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1. СОСТАВ ПАКЕТА ПРИКЛАДНЫХ ПРОГРАММ ORCAD 
 Пакет прикладных программ Orcad предназначен для автоматизации процесса 
проектирования электронных устройств. Он позволяет провести моделирование 
переходных процессов, рассчитать частотные и шумовые характеристики 
аналогового, цифрового или аналого-цифрового устройства, заданного 
принципиальной схемой, оптимизировать параметры устройства в соответствии с 
заданной целевой функцией, разработать печатную плату. Кроме перечисленных 
возможностей последняя версия пакета (Orcad 10) включает новые возможности по 
проектированию устройств на базе FPGA/CPLD интегральных схем; позволяет 
работать с программами размещения и трассировки от фирм-изготовителей 
кристаллов Xilinx, Altera и Actel (при предварительной инсталляции программ). 
 Назначение отдельных программ, входящих в состав пакета, приведено в табл. 
1.1. 
 

Таблица 1.1 
Программы пакета Orcad 9.2 

Название программы Назначение 

Capture CIS 
Управляющая оболочка, позволяющая вводить и 
редактировать принципиальную схему в графическом 
режиме, а также вызывать остальные программы пакета 

Layout Plus Разработка печатных плат 

PSpice AD Программа моделирования аналоговых, цифровых и 
аналого-цифровых устройств 

PSpice Model Editor Редактирование существующих и создание новых 
библиотек элементов 

PSpice Optimizer 
Оптимизация параметров устройства для достижения 
наилучшего функционирования в соответствии с 
целевой функцией 

PSpice Simulation Manager Управление заданиями на моделирование устройства 

PSpice Stimulus Editor Редактор входных воздействий 

 
 Для выполнения нужных разработчику действий может вызываться либо 
непосредственно необходимая в данный момент программа (например PSpice Model 
Editor), либо управляющая оболочка (Capture CIS) с последующим выбором 
необходимого действия. Последний путь обладает большей целостностью и 
наглядностью и может быть рекомендован при создании нового проекта, а также 
начинающим пользователям. 
 Запуск выбранной программы осуществляется либо с помощью меню Пуск 
(например, Пуск → Программы → Orcad Family Release 9.2 Lite Edition → Capture CIS 
Lite Edition), либо любым другим известным путем. 
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Рис. 2.1. Стартовое окно программы 

Рис. 2.2. Окно при создании  
нового проекта 

2. ПРОГРАММА CAPTURE CIS 

2.1. Рабочее окружение 
 После запуска на выполнение на экране появляется окно программы, 
приведенное на рис. 2.1. 

 В левом нижнем углу расположено 
минимизированное окно Session Log, в 
которое записывается информация о 
действиях, произведенных в течение сеанса 
работы с управляющей оболочкой.  
 При выборе пункта меню File→New 
программа Capture предложит создать: 
новый проект (Project), разработку (Design), 
библиотеку (Library), VHDL или текстовый 
файл. Файл проекта (расширение .OPJ) 
содержит указатель на один файл 
разработки (.DSN), а также библиотеки, 

VHDL файлы, выходные файлы отчетов, связанные с файлом разработки. В файле 
разработки находятся одна или несколько папок (schematic folders), содержащих по 
одному или несколько листов схемы (schematic pages), а также кэш разработки, 
который, подобно библиотеке, содержит копии всех элементов, использованных в 
разработке.  

При создании нового проекта на экране появится окно, представленное на рис. 2.2.  
Кроме имени проекта (Name) и его 

местоположения на диске пользователя 
(Location) необходимо выбрать тип проекта: 
 Analog or Mixed A/D – при дальнейшем 
использовании программы PSpice; 
 PC Board Wizard – при дальнейшем 
использовании программы Layout; 
 Programmable Logic Wizard – при 
разработке схемы на основе ПЛИС; 
 Schematic – при необходимости создания 
только чертежа принципиальной либо 
функциональной схемы без дальнейшего 
моделирования либо разработки печатной 
платы. 
 

Рис.2.2 Окно при создании 
нового проекта 

 Создав новый либо открыв существующий проект, в левой части экрана можно 
увидеть окно менеджера проекта (рис. 2.3), который является удобным средством 
управления файлами проекта. 
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Рис. 2.3. Вид экрана при открытии проекта 

Для редактирования выбранного файла в отдельном окне необходимо произвести 
двойной щелчок левой кнопкой мыши на выбранной пиктограмме.  

Для добавления нового файла в проект необходимо: 
I вариант: 
 1) выбрать в менеджере проектов папку, в которую будет добавляться файл; 
 2) из меню Edit выбрать пункт Project; 
 3) выбрать нужный файл в появившемся диалоговом окне Add File to Project 
Folder и нажать кнопку Open. 
II вариант: 
 перетащить файл из окна Windows Explorer в нужную папку менеджера проекта. 
 Щелчок правой кнопкой мыши на файле или папке в окне менеджера проекта 
вызывает появление контекстного меню, зависящего от назначения данного файла 
или папки. Вид контекстных меню для файлов, содержащих чертеж принципиальной 
схемы, и файлов, содержащих задание на моделирование, приведен на рис. 2.4, а и б 
соответственно. 
 
 
 

 
Рис. 2.4. Контекстные меню 

 
 

а б 
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 Для удаления файла необходимо выделить его в окне менеджера проекта и 
нажать клавишу Delete. 

Удобным средством, облегчающим взаимодействие пользователя с программой, 
являются панели инструментов, взаимное положение которых можно изменять 
перетягиванием мышью. Назначение различных инструментов приведено в табл. 2.1, 
2.2 и 2.3. 

Таблица 2.1 
Инструменты Capture 

Пикто-
грамма Название Назначение Выполнение через 

меню 

 

Перекрест-
ная ссылка 

Создает таблицу, содержащую 
информацию о номинале элемента, его 
позиционном обозначении, 
библиотечном источнике и др. 

Tools → Cross  

Reference 

 
 

 

Список 
материалов 

Создает список количества и 
номиналов элементов для выбранной 
страницы 

Tools → Bill of 
Materials 

 

 

Привязка 
к сетке 

Включает (выключает) привязку к 
сетке 

Options→ Preferences→ 
Grid Display→ Pointer 

snap to grid 

 

Менеджер 
проекта Отображает менеджер проекта Window → название 

проекта.opj 

 

Часто 
используе-

мый 
элемент 

Вставляет элемент из списка наиболее 
часто используемых  

 

Увеличе-
ние Увеличение View → Zoom → In 

 

Умень-
шение Уменьшение View → Zoom → Out 

 

Увеличить 
выбранное 

Увеличивает выбранный прямоуголь-
ник View → Zoom → Area 

 

Увеличить 
все Показывает всю схему View → Zoom → All 

 
Связать Присваивает позиционные обозна-

чения введенным элементам Tools → Annotate 

 

Внести  
изменения 

Позволяет внести изменения, 
сделанные в других программах 
(например Layout) 

Tools → Back Annotate 
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Окончание табл. 2.1 

 

Проверка 
правил 

Проверка схемы на выполнение 
основных электрических и конструк-
ционных правил. Позволяет найти 
ошибки 

Tools → Design Rules 
Check 

 

Создать 
описание 

схемы 

Создает файл-описание схемы в 
формате, задаваемом пользователем Tools → Create Netlist 

 
Таблица 2.2 

Инструменты редактора схем 
Пикто-
грамма Название Назначение Выполнение 

через меню 

 
Выбор Выбирает объекты   

 
Элемент Выбирает элемент из библиотеки 

для вставки в схему Place → Part 

 
Соединение 

Рисует провода, электрически 
соединяющие точки схемы. 
Удержание клавиши Shift позволяет 
рисовать неортогональные провода 

Place → Wire 

 
Имя цепи Позволяет назначить имя проводу 

или шине Place → Net Alias 

 
Шина 

Рисует шины. Удержание клавиши 
Shift позволяет рисовать неорто-
гональные сегменты 

Place → Bus 

 
Узел Вводит узел Place → Junction 

 
Вход шины Рисует входы шины Place → Bus Entry 

 
Питание Рисует символы питания Place → Power 

 
Земля Рисует символы «земли» Place → Ground 

 

Иерархичес-
кий блок Вставляет иерархический блок 

Place → Hierarchical 
Block 
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Окончание табл. 2.2 

 

Иерархи-
ческий порт Вставляет иерархический порт Place → Hierarchical Port 

 

Иерархи-
ческий 
вывод 

Вставляет иерархический вывод Place → Hierarchical Pin 

 

Межстра-
ничный 

соединитель 

Добавляет межстраничный 
соединитель 

Place → Off-Page Con-
nector 

 

Нет 
соединений 

Вставляет символ  
«нет соединения» Place → No Connect 

 
Линия Рисует линию Place → Line 

 
Полилиния Рисует линию с точками изгиба Place → Polyline 

 

Прямо-
угольник 

Рисует прямоугольник. Удер-
жание клавиши Shift позволяет 
нарисовать квадрат 

Place → Rectangle 

 
Эллипс 

Рисует эллипс. Удержание 
клавиши Shift позволяет 
нарисовать правильный круг 

Place → Ellipse 

 
Дуга Рисует часть окружности Place → Arc 

 
Текст Позволяет вводить текст Place → Text 

Таблица 2.3 

Инструменты редактора элементов 

 

IEEE 
символ 

Помещает на изображение 
элемента его функциональное 
назначение в виде стандартного 
IEEE символа 

Place → IEEE Symbol 

 
Вывод Рисует вывод элемента Place → Pin 

 

Массив  
выводов Рисует массив выводов Place → Pin Array 
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В нижней части окна расположена строка состояния (рис. 2.5), на которой 
отображаются (слева направо) состояние выбранного инструмента либо пояснение к 
пункту меню; количество выбранных элементов; текущий масштаб и положение 
курсора. 
 
 
 

Рис. 2.5. Строка состояния 

 Строку состояния и панели инструментов можно убрать с экрана, выбрав 
соответствующий пункт меню View. 

2.2. Подготовка схемы и моделирование на PSpice 
Перед созданием нового проекта необходимо в стартовом окне программы Capture 

(см. рис. 2.1)  выбрать  пункты  меню  Options → Design  Templates,   Options → 
Preferences и установить требуемые единицы измерения, размеры страницы, шаг и 
привязку сетки,  другие необходимые параметры. В противном случае проект будет 
создан по шаблонам, установленным ранее. 

При создании нового проекта (File → New → Project) необходимо в окне создания 
нового проекта (см. рис. 2.2) указать его тип либо как «Analog or Mixed A/D», либо 
как «PC Board Wizard». В последнем случае в появившемся окне мастера создания 
PCB проекта (рис. 2.6)  необходимо активизировать пункт Enable project simulation. 

 
 
 
 
 
 
 
 
 
 

Рис. 2.6. Окно мастера создания PCB проекта 
После создания проекта производится ввод принципиальной схемы 

пользователя с помощью инструментов редактора принципиальных схем (см. табл. 
2.3).  

Как правило, сначала производится ввод элементов принципиальной схемы с 
помощью кнопки «Элемент» (или нажатия на клавиатуре клавиши P), при этом на 
экране появляется окно Place Part (рис. 2.7). В левом нижнем углу окна расположен 
список библиотек, из которого производится выбор нужного элемента, при этом 
путем выделения можно указать как одну библиотеку, так и все сразу. Отметим, что 
для дальнейшего моделирования схемы с помощью программы PSpice необходимо 
выбирать только те элементы, которые снабжены моделью на языке моделирования, о 
чем свидетельствует наличие пиктограммы PSpice под изображением элемента. При 
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необходимости дальнейшей разработки печатной платы элемент должен содержать 
также описание посадочного места, о чем свидетельствует наличие пиктограммы 
Layout. При необходимости список используемых библиотек можно увеличить либо 
уменьшить с помощью соответствующих кнопок, при этом библиотеки с моделями на 
языке PSpice расположены по адресу C:\Program Files\OrcadLite\Capture\Library\PSpice 
и имеют расширение *.olb. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.7. Назначение элементов окна Place Part 

 Если библиотека, содержащая нужный элемент, неизвестна, то можно 
произвести поиск во всех библиотеках из заданной папки с помощью команды Part 
Search. 
 При нажатии кнопки ОК курсор перемещается на страницу с принципиальной 
схемой, при этом ввод элемента осуществляется нажатием левой кнопки мыши. При 
необходимости поворота элемента щелчком правой кнопкой мыши вызывается 
контекстное меню, из которого выбирается пункт Rotate. После ввода нужного 
количества элементов производится либо вызов контекстного меню с последующим 
выбором команды End Mode, либо нажатие клавиши Esc. Электрическое соединение 
элементов производится с помощью инструмента «Соединение» (вызов либо с 
помощью панели инструментов, либо нажатием клавиши W). При этом щелчок в 
месте пересечения двух проводов добавляет узел, в противном случае 
пересекающиеся провода электрически не соединяются. При необходимости 
изменения номинала либо позиционного обозначения элемента производится двойной 
щелчок мыши на изменяемом параметре. Двойной щелчок на изображении самого 
элемента вызывает редактор свойств; отбор и редактирование необходимых свойств 
проще осуществлять с использованием фильтра (рис. 2.8). 
  
 
 

 
  

Рис.2.8. Редактор свойств 
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Рис. 2.9. Окно при вызове инструмента 
GND 

 Обязательным условием возможности моделирования схемы является наличие 
элемента «земля», имеющего имя «0». Для этого надо с помощью инструмента 

«Земля» поместить на схему этот элемент (рис. 
2.9), находящийся в библиотеке Source. 
Альтернативным решением является 
использование другого элемента «земля» с 
последующим присваиванием ему имени «0». 
 Для анализа схемы в переходном режиме 
кроме стандартных входных воздействий 
(синусоидального, прямоугольного) могут 
потребоваться источники входных воздействий 
(Stimulus sources), задаваемые пользователем. 
Наиболее простым путем создания данного 
источника является использование источника из 

библиотеки Sourcstm.olb (C:\Program Files\OrcadLite\Capture\Library\PSpice\ 
Sourcstm.olb), в которой представлены: 
 VSTIM – аналоговые источники напряжения;  
 ISTIM – аналоговые источники тока; 
 DIGSTIMn – источники цифровых сигналов. 
 После размещения источника на схеме с помощью правой кнопки мыши 
вызывается контекстное меню, из которого выбирается пункт Edit PSpice Stimulus, 
после чего можно произвести редактирование входного воздействия с помощью 
редактора Stimulus Editor. 
 После окончания ввода принципиальной схемы желательно проверить ее на 
наличие ошибок, для чего либо воспользоваться инструментом «Проверка правил» 
(см. табл. 2.2), либо выбрать пункт меню Tools → Design Rules Check. 

Пункт меню Tools и инструмент «Проверка правил» становятся доступными при 
активации окна менеджера проекта. 

После этого на экране возникает окно, показанное на рис. 2.10.  
Для того чтобы сразу просмотреть файл отчета, 

необходимо установить флажок View Output. 
 Состав сведений, включаемых в отчет, 
выбирается с помощью установки соответствующего 
флажка в группе Report, а именно: 

Create DRC markers for warnings – создает 
маркеры не только для ошибок, но и для 
предупреждений; 
 Check hierarchical port connections – 
проверяет соответствие иерархических портов на 
главной и дочерней страницах схемы; 
 Check off-page connector connections – 
проверяет соответствие имен межстраничных 

соединителей на всех страницах схемы; 
 

Рис. 2.10. Окно при вызове 
инструмента DRC 
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 Report identical part reference – проверяет наличие идентичных ссылок на 
разные элементы; 
 Report invalid packaging – проверяет на правильность размещения элементов 
по корпусам; 
 Report hierarchical ports and off-page connectors – включает в файл отчета 
сведения об иерархических портах и межстраничных соединителях; 
 Check unconnected nets – проверяет наличие неприсоединенных цепей (каждая 
цепь обязательно должна иметь путь к «земле»), а также наличие цепей с 
одинаковыми именами; 
 Check SDT compatibility – проверяет на совместимость с Инструментами 
Разработки Схем (SDT – Schematic Design Tools). Проверка данного пункта 
необходима при дальнейшем сохранении схемы в формате SDT. 
 Report off-grid objects – включает в отчет сведения об объектах, лежащих вне 
сетки; 
 Report all net names – включает в отчет сведения обо всех именах цепей. 

Предупреждение – сообщение, при котором возможно (в отличие от ошибки) 
дальнейшее моделирование схемы. Для конкретной схемы в зависимости от 
логики ее работы часть предупреждений может игнорироваться разработчиком, 
часть должна быть обязательно учтена. 

Кроме файла отчета, информация об ошибках размещается на изображении 
принципиальной схемы в виде зеленого кружка рядом с элементом, для которого 

обнаружена ошибка. Двойной щелчок на кружке 
выводит на экран описание ошибки. 

Выбор ситуаций, которые необходимо 
рассматривать как ошибку, либо выдавать 
предупреждение, может осуществляться 
пользователем с помощью выборка вкладки ERC 
Matrix в окне рис. 2.10. Матрица правил проверки 
ошибок изображена на рис. 2.11. Выбор значка «Е» 
на пересечении соответствующей строки и столбца 
(путем щелчка левой кнопкой мыши) приводит к 
рассмотрению данной ситуации как ошибки; 
значок «W» позволяет сгенерировать 
предупреждение. Моделирование схемы 
осуществляется либо с помощью панели 

инструментов (табл. 2.4), представленной на рис. 2.12, либо с помощью пункта меню 
PSpice (табл. 2.5). 

 
 
 

Рис. 2.12. Панель инструментов для программы PSpice 
 
 
 

Таблица 2.4  

Рис. 2.11. Матрица правил 
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Назначение инструментов для программы PSpice 
Пиктограмма Назначение 

 
Создает новый профиль (набор параметров) моделирования 

 
Редактирует параметры моделирования 

 
Запускает программу PSpice в режиме моделирования 

 
Позволяет просмотреть результаты моделирования 

 
Устанавливает маркер напряжения. Позволяет определить 
напряжение в заданной точке относительно потенциала «земли» 

 
Устанавливает два маркера, между которыми определяется 
напряжение 

 
Устанавливает маркер тока 

 
Устанавливает маркер мощности 

, ,  

Позволяет просмотреть результаты анализа цепи (напряжения, токи, 
мощности в узлах) по постоянному току. Для активации этих 
инструментов должен быть активирован пункт меню PSpice → Bias 
Points → Enable 

, ,  

Позволяет скрыть выделенный параметр (напряжение, ток, 
мощность). Для активации соответствующего инструмента должен 
быть активен инструмент «V», «I», «W» соответственно 

Таблица 2.5 
Команды меню PSpice 

Название Назначение 

New Simulation Profile Создает новый профиль моделирования 

Edit Simulation Profile Редактирует существующий профиль моделирования 

Run Запускает программу PSpice в режиме моделирования 
View Simulation Results Позволяет просмотреть результаты моделирования. 

View Output File Позволяет просмотреть текстовый файл с результатами 
моделирования 

Create Netlist Создает текстовый файл *.net, содержащий описание 
схемы 

View Netlist Позволяет просмотреть созданное (*.net) описание схемы  
Place Optimizer Parameters  Задает параметры для программы PSpice Optimizer 

Run Optimizer Запускает программу PSpice Optimizer 

Markers Задает маркеры, отмечающие необходимые для расчета 
напряжения, токи, мощности 

Bias Points Выдает результаты расчета цепи по постоянному току 
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 Перед началом моделирования необходимо создать профиль (набор параметров) 
моделирования, воспользовавшись соответствующим инструментом (см. табл. 2.4) 
либо пунктом меню (табл. 2.5), затем указать имя для создаваемого профиля. Вид 
анализа схемы и параметры моделирования указываются в окне рис. 2.13. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2.13. Создание профиля моделирования 
 
 Вид анализа (Analysis type) может быть выбран как: 
 Time Domain (Transient) – анализ цепи во временной области (расчет 
переходного процесса); 
 DC Sweep – расчет цепи по постоянному току при изменении источников 
питания, параметров моделей элементов или температуры в заданных пределах; 
 AC Sweep/Noise – расчет АЧХ и ФЧХ цепи; при дополнительной активации 
раздела Noise – расчет шумовых характеристик (вклада каждого источника шумов в 
выходной сигнал, среднеквадратичной суммы шума на выходе от действия всех 
шумовых генераторов, расчет эквивалентного входного источника шума); 
 Bias Point – расчет цепи по постоянному току. 
 В разделе Options кроме общих установок (General Settings), определенных при 
выборе вида анализа, можно дополнительно задать: 
 Monte Carlo/Worst Case – статистический анализ методом Монте–Карло либо 
расчет цепи на наихудший случай; 
 Parametric Sweep – изменение параметра схемы; 
 Temperature (Sweep) – температуру, при которой рассчитывается работа схемы 
и ее изменение; 
 Save Bias Points – сохранение результатов анализа схемы по постоянному току 
в отдельный файл; 
 Load Bias Points – загрузка из файла значений, определяющих режим работы 
схемы по постоянному току. 
 Вид правой части окна рис. 2.13 определяется выбором вида анализа и 
дополнительных параметров моделирования. Для выполнения анализа схемы по 
переменному току (расчета АЧХ и ФЧХ) необходимо указать: 
 Start Frequency – начальную частоту анализа; 
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 End Frequency – конечную частоту анализа; 
 Linear – при необходимости линейного изменения частоты; 
 Logarithmic – при необходимости логарифмического изменения частоты 
(Decade – по декадам, Octave – по октавам); 
 Points/Decade – количество точек расчета на одну декаду; 
 Total Points – общее количество точек расчета. 
 Для обработки результатов анализа с помощью постпроцессора Probe 
необходимо на вкладке окна (см. рис. 2.13) выбрать закладку Probe Window и 
установить переключатель Display Probe window. 

Постпроцессор Probe позволяет просмотреть результаты анализа в виде графиков, 
что намного нагляднее результатов, представленных в текстовом файле *.out. 
После создания профиля моделирования необходимо запустить программу PSpice 

путем нажатия пиктограммы с синей стрелкой. При отсутствии ошибок на экране 
появится окно программы PSpice с результатами моделирования, приведенное на рис. 
2.14. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.14. Результаты моделирования 

В случае, когда не была указана требуемая выходная величина, в окне результатов 
моделирования будет отображаться только координатная сетка. Для отображения 
необходимого графика необходимо добавить его в число видимых на экране с 
помощью пункта меню Trace → Add Trace (либо щелкнув мышью на пиктограмме, 
указанной на рис. 2.14). 
 В табл. 2.6 приведено описание инструментов обработки результатов 
моделирования, которые позволяют представить результат в наиболее удобной форме, 
а также провести дополнительный анализ функционирования схемы. 
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Таблица 2.6 

Инструменты для обработки результатов моделирования 

Пикто-
грамма Назначение Выполнение  

через меню 

 
Отображает логарифмическую шкалу по оси Х Tools → Axis Settings 

 

Выполняет Фурье-анализ. Для выполнения 
данного пункта должен быть рассчитан 
переходный процесс 

Trace → Fourier 

 
Позволяет сравнить характеристики семейства 
выходных сигналов 

Trace → Performance 
Analysis 

 
Отображает логарифмическую шкалу по оси Y Tools → Axis Settings 

 
Строит график для указанной переменной Trace → Add Trace 

 
Вычисляет целевую функцию Trace → Eval Goal Function 

 
Вставляет текстовую метку Plot → Label → Text 

 
Помечает рассчитанные точки — 

 

Включает отображение курсора. Является 
удобным средством для измерения значений 
непосредственно по графику 

Trace → Cursor → Display 

2.3. Моделирование функциональных схем 
 С помощью программ Capture – PSpice можно моделировать электрические 
схемы не только на уровне принципиальной схемы, но также и на уровне 
функциональной, что является удобным средством на этапе предварительного 
определения параметров каждого блока устройства. 
 Для моделирования схемы на функциональном уровне необходимо 
использовать библиотеку АВМ (Analog Behavioral Modeling), расположенную по 
адресу C:\Program Files\OrcadLite\Capture\Library\PSpice\abm.olb. 
 Весь набор элементов этой библиотеки можно разбить на два подмножества: 
элементы систем управления и PSpice-эквивалентные элементы. Элементы систем 
управления имеют один вход и один выход. Предполагается, что входные (выходные) 
сигналы этих элементов действуют между входом (выходом) элемента и «землей», 
при этом вид используемого сигнала (ток, напряжение и т.д.) безразличен. PSpice-
эквивалентные элементы отражают структуру управляемых источников тока (G) и 
напряжения (Е), используемых в программе PSpice, и имеют дифференциальный вход 
и симметричный выход. Описания элементов библиотеки АВМ приведены в табл. 2.7 
и 2.8. 
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Таблица 2.7 

Элементы систем управления 

Категория Элемент Описание Параметры 

Основные 
компоненты 

CONST Константа VALUE  
SUM Сумматор  
MULT Умножитель  
GAIN Усилитель GAIN 
DIFF Вычитание  

Ограничители 

LIMIT Ограничитель LO, HI 
GLIMIT Усилитель-ограничитель LO,HI,GAIN 

SOFTLIM «Мягкий» усилитель-
ограничитель LO,HI,GAIN 

Фильтры 
Чебышева 

LOPASS Фильтр нижних частот FP, FS, RIPPLE, STOP 
HIPASS Фильтр верхних частот FP, FS, RIPPLE, STOP 
BANDPASS Полосовой фильтр FP, FS, RIPPLE, STOP 
BANDREJ Режекторный фильтр FP, FS, RIPPLE, STOP 

Интегратор и 
дифференциатор 

INTEG Интегратор GAIN, IC 
DIFFER Дифференциатор GAIN 

Передаточная 
функция от 

комплексной 
переменной s 

LAPLACE 

Элемент, задаваемый 
передаточной функцией 
от комплексной перемен-
ной s 

NUM, DENOM 

Таблицы 
соответствия 

TABLE 

Элемент, задаваемый 
таблицей: входное на-
пряжение – выходное 
напряжение 

ROW1…ROW5 

FTABLE 

Элемент, задаваемый 
таблицей: частота 
входного сигнала – 
ослабление в дБ – фаза 

ROW1…ROW5 

Математические 
функции 

ABS x   

SQRT x   

PWR EXPx  EXP 

PWRS EXPx  EXP 
LOG ln(x)  
LOG10 log(x)  
EXP ex  
SIN, COS, 
TAN sin(x), cos(x), tan(x)  

ATAN, 
ARCTAN tan-1(x)  

Функции 
пользователя ABM 

Элемент без входа и 
одним выходом по 
напряжению 

EXP1..EXP4 
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Окончание табл. 2.7 

Категория Элемент Описание  Параметры 

Функции 
пользователя 

ABM1 
Элемент с одним входом 
и одним выходом по 
напряжению 

EXP1..EXP4 

ABM2 
Элемент с двумя 
входами и одним 
выходом по напряжению 

EXP1..EXP4 

ABM3 
Элемент с тремя входами 
и одним выходом по 
напряжению 

EXP1..EXP4 

ABM/I Элемент без входа и 
одним токовым выходом  EXP1..EXP4 

ABM1/I Элемент с одним входом 
и токовым выходом EXP1..EXP4 

ABM2/I 
Элемент с двумя 
входами и токовым 
выходом 

EXP1..EXP4 

ABM3/I Элемент с тремя входами 
и токовым выходом EXP1..EXP4 

 
В табл. 2.7 использованы следующие обозначения параметров: 
VALUE – значение; 
GAIN – коэффициент усиления (в разах); 
LO – нижний уровень; 
HI – верхний уровень; 
FP – граничная частота полосы пропускания; 
FS – граничная частота полосы задерживания; 
RIPPLE – неравномерность АЧХ в полосе пропускания (в дБ); 
STOP – затухание в полосе задерживания (в дБ); 
F0, F1, F2, F3 – частоты среза; 
IC – начальное значение; 
NOM – числитель; 
DENOM – знаменатель; 
ROW – строка; 
EXP – арифметическое выражение. 

Аргументы тригонометрических функций должны быть указаны в радианах. 
 PSpice-эквивалентные элементы могут быть классифицированы как 

приборы E и G типов. Так как передаточные функции данных элементов могут 
содержать произвольную комбинацию входных токов и напряжений, то тип 
используемого элемента определяется только необходимым выходным сигналом 
(током или напряжением). 
 На языке моделирование описание PSpice-эквивалентного элемента имеет 
следующий вид: 
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E <name> <connecting nodes> <ABM keyword> <ABM function>, 
где name – имя устройства; 
       connecting nodes – узлы подключения; 
       ABM keyword – определяет вид используемой передаточной функции, а 
именно: 
   VALUE – арифметическое выражение; 
   TABLE – таблица соответствия; 
   LAPLACE – функция комплексной переменной s; 
   FREQ – таблица соответствия в частотной области; 
   CHEBYSHEV – характеристика фильтра Чебышева; 
    ABM function – описание передаточной функции в виде формулы либо 
таблицы соответствия. 

Пример: рассмотрим умножитель, имеющий четыре входа и два выхода. Его 
описание имеет вид 

E^@REFDES %OUT+ %OUT- VALUE {V(%IN1+,%IN1-)*V(%IN2+,%IN2-)}. 
 

Таблица 2.8 
PSpice-эквивалентные элементы 

Категория Элемент  Описание Параметры 

Математические 
выражения 

EVALUE, 
GVALUE Функция EXPR 
ESUM, 
GSUM Сумматор — 

EMULT, 
GMULT Умножитель — 

Таблица 
соответствия 

ETABLE, 
GTABLE Таблица соответствия EXPR, TABLE 

EFREQ, 
GFREQ 

Таблица: входная 
частота – выходное 
напряжение (ток) 

EXPR, TABLE 

Передаточная 
функция от 

комплексной 
переменной s 

ELAPLACE, 
GLAPLACE 

Элемент, задаваемый 
передаточной функцией 
от комплексной пере-
менной s 

EXPR, XFORM 

 
 В табл. 2.8 использованы следующие обозначения параметров: 
 EXPR – математическая функция от двух (в отличие от EXP) входных сигналов; 

TABLE – таблица; 
XFORM – функция от комплексной переменной s. 

Пример: EXPR = 15ma*SIN(6.28*10kHz*TIME+V(%IN+,%IN-)); 
         TABLE = (0, 0) (.02, 2.690E-03) (.04, 4.102E-03) (.06, 4.621E-03);   

                     XFORM = 1/(1+.001*s). 
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3. ПРОГРАММА PSPICE 

3.1. Алгоритм подготовки схемы к моделированию 
 Для запуска программы PSpice без запуска программы Capture необходимо 
выбрать следующие пункты меню «Пуск»: Пуск → Программы → Orcad Family 
Release 9.2 Lite Edition → PSpice AD Lite Edition. 
 В появившемся на экране окне программы необходимо создать новый 
текстовый файл, используя команды меню «File» (File → New → Text File). В 
появившемся окне нового документа необходимо набрать текст программы на языке 
моделирования. 
 После ввода схемы необходимо сохранить файл на диск (в компьютерном 
классе кафедры ТОЭ в папку D:\Work) в виде  <имя файла>.cir. После этого 
необходимо закрыть созданный текстовый файл и открыть файл в формате описания 
схемы (*.cir).  
 После выполнения указанных действий на панели инструментов появляется 
синяя стрелка, щелчок на которой запускает процесс моделирования. 
 

3.2. Входной язык 
В программе SPICE информация о схеме и необходимых видах и параметрах 

анализа задается во входном текстовом файле, который формируется в соответствии 
со входным языком. 

Формат входного языка свободный, т.е. нет жестких требований к 
последовательности записи входной информации. В качестве разделителей для полей 
записей используются пробел(ы), запятая, знак равенства или левая и правая скобки. 
Пробелы в записи, не используемые в качестве разделителей, игнорируются. Любая 
запись может быть перенесена на следующую строку, для чего в начале строки 
необходимо поместить знак плюс. Поле имени в записи должно начинаться с буквы 
латинского алфавита (A–Z) и не может содержать перечисленные выше разделители. 
Информационные поля могут быть целочисленными, с плавающей точкой, 
использовать экспоненциальную форму или сопровождаться следующими 
масштабными коэффициентами: 

Т=1Е12;  G=1E9;  MEG=1E6; K=1E3; 
М=1Е-3;  U=1E-6;   N=1E-9;   P=1E-12;  F=1E-15. 
Символы, следующие сразу за числом и не являющиеся масштабными 

коэффициентами, игнорируются. Например: 
1000=1000.0=1000HZ=1E3=1.0ЕЗ=1КНZ=1К=0.001MEGHZ. 
Существует два типа записей: 
1) записи описания элементов схемы; 
2) управляющие записи, или директивы управления.  
Первый тип записей определяет топологию схемы, ее состав и значения 

элементов. Второй тип записей управляет работой программы и задает параметры 
моделей элементов. 
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Первая запись во входном файле всегда является заголовком. Последняя должна 
быть всегда директивой [.END]. Порядок остальных записей произвольный. 

Отсутствие заголовка приводит к тому, что первая строка описания схемы 
исключается из рассмотрения, что приводит к ошибке. 

Каждый элемент схемы описывается записью, которая содержит имя элемента, 
узлы подключения элемента и параметры, определяющие его электрические 
характеристики. Первая буква в имени элемента задает его тип. 

Номерами узлов схемы должны быть произвольные целые неотрицательные числа. 
Узел, соответствующий «земле», имеет номер ноль и должен обязательно 
присутствовать в описании схемы. 

Токи в ветвях схемы всегда направлены по уменьшению напряжения. Схема не 
может содержать контуров из источников напряжения и (или) индуктивностей и 
сечений из источников тока и (или) емкостей. К каждому узлу в схеме должны быть 
подключены по крайней мере две ветви (за исключением конечных узлов линии с 
распределенными параметрами и узлов подложки МОП-транзисторов). Любой узел 
должен иметь путь по постоянному току к «земле». 

Входной язык позволяет вставлять записи с комментариями в любое место 
входного файла. Строка с комментарием должна начинаться с символа «*». При 
добавлении комментария в конец строки используется символ «;». 

Напишем программу для расчета амплитудно-частотной характеристики (АЧХ) 
схемы,  представленной на рис. 3.1, с параметрами R=50 Ом, 

     L=0,25 Гн, C=2 мкФ: 
PRIMER 
R 1 2 50 
L 2 3 0.25 
C 3 0 2U 
VIN 1 0 AC 1 
.AC LIN 100 30 300 
.PLOT AC V(3) 
.PROBE 
.END 

Отметим, что в схеме обязательно должен присутствовать источник, тип которого 
определяется требуемым видом анализа схемы. 

Директива .PROBE служит для запуска постпроцессора, позволяющего 
представить результаты моделирования в графическом виде. 
 Подробное описание элементов схемы и директив управления приведено ниже. 

3.3. Описание элементов электронных схем 
Для задания структуры электронной схемы применяются записи с описаниями 

элементов, которые содержат информацию об узлах подключения и значениях 
параметров моделей. Рассмотрим составление данных записей более подробно. 

 
 
 
 

 
R L

UСU 
С 

1 2 3 

0 
Рис. 3.1. Схема примера 
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3.3.1. Резисторы:  
Rимя N1 N2 <Имя модели> [Номинал], 

где  R – идентификатор резистора; 
имя – позиционное обозначение элемента в схеме; 
N1, N2 – узлы подключения резистора (положительное направление тока через 

резистор от N1 узла к узлу N2); 
Номинал – величина сопротивления резистора (может быть положительной, 

отрицательной, но не нулевой). В случае необходимости в нулевом сопротивлении 
необходимо ввести значение, много меньшее других сопротивлений в схеме 
(например 1Е-6). 

Имя модели – имя модели, описывающей зависимость сопротивления от 
температуры. 

Параметры модели резистора приведены в табл. 3.1. 
Примечание. В дальнейшем между символами “<” и  “>” будем размещать 

необязательные параметры. 
Таблица 3.1 

Параметры модели резистора 

Параметр Коэффициенты Ед.изм. Значение по 
умолчанию 

R Масштабный – 1 

ТС1 Линейный температурный 1/оC 0 

TC2 Квадратичный  
температурный 1/оC2 0 

ТСЕ Экспоненциальный  
температурный 1/оC 0 

T_ABS Абсолютная температура оC 27 

T_MEASURED Температура измерений оC 27 

T_REL_GLOBAL Относительная температура оC 0 

T_REL_LOCL Разность между температурой 
резистора и модели-прототипа 

оC 0 

 
Описание модели резистора в общем случае имеет следующий вид:  

.MODEL [Имя модели] RES <R=3H1> <ТС1=3Н2> <ТС2=3НЗ>, 
где  Имя модели  –  имя модели резистора; 
        ЗН1, ЗН2, ЗНЗ – значения параметров. 

Параметрам, не указанным в описании модели, присваиваются значения по 
умолчанию. Если модель не задана, то значение сопротивления резистора 
принимается равным номиналу. Если в модели не указан параметр ТСЕ, то величина 
сопротивления резистора r определяется по формуле 

r = Hoминал * R *[l+(T-T0)*TC1+(T-T0)2 
* TC2]. 

В случае, если параметр ТСЕ задан, то величина сопротивления резистора r 
определяется как 
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r = Номинал * R * 1.01TCE*(T-T0). 
R1 15 0 2К 
*Резистор R1, включенный между узлами 15 и 0 номиналом 2КОм 

     RG 1 2 mod_my 2E2. 
          *Резистор RG, включенный между узлами 1 и 2, имеющий номинал *200Ом и 
описываемый моделью mod_my. 

3.3.2. Конденсаторы:  

Симя Nl N2 <Имя модели> [Номинал] <IС>, 
где С – идентификатор конденсатора; 

имя – обозначение элемента на схеме; 
      N1,N2   – узлы подключения конденсатора; 
      Номинал– величина емкости конденсатора (может быть положительной, 
отрицательной,  но не нулевой); 

IС – начальное значение напряжения на конденсаторе. 
Параметры модели конденсатора приведены в табл. 3.2 

Таблица 3.2 
Параметры модели конденсатора 

Параметр Коэффициенты Ед.изм. Значение по 
умолчанию 

С Масштабный – 1 

VС1 При линейной части  
VC 1/V 0 

VC2 При квадратичной части VC  1/V2 0 

ТС1  Линейный температурный  1/оC 0 

ТС2 Квадратичный температурный 1/оC2 0 

T_ABS Абсолютная температура оC 27 

T_MEASURED Температура измерений оC 27 

T_REL_GLOBAL Относительная температура оC 0 

T_REL_LOCL Разность между температурой 
конденсатора и модели-прототипа 

оC 0 

Описание модели конденсатора в общем случае имеет следующий вид:  
.MODEL [Имя] CAP <П1=ЗН1> <П2=ЗН2> ....... , 

где Имя    – имя модели; 
П1,П2,…    – наименования параметров; 

      ЗН1,ЗН2,…– значения параметров. 
Параметрам, не указанным в описании модели, присваиваются значения по 

умолчанию. Если модель не задана, то величина емкости конденсатора принимается 
равной номиналу. 

 Если модель задана, то значение емкости определяется по формуле 
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С = ( Номинал*С)*(l+VC*VC1+VC2
*VC2)*[l+(T–TO)*TC1+(T–TO)2 

*TC2]. 

Задание начального напряжения на конденсаторе позволяет уменьшить 
время расчета переходного процесса. 
CLOAD 15 0 20PF 

С2 1 2.2Е-12 IC=15V 
CFDB 3 4 CMOD 10PF 

3.3.3. Индуктивности: 
Lимя  Nl  N2 <Имя модели> [Номинал] <IС>, 

где   L – идентификатор индуктивности; 
        имя – обозначение элемента на схеме; 
        Nl, N2 – узлы подключения индуктивности; 
        Номинал – величина индуктивности (может быть положительной, отрицательной, 
но не нулевой); 
        IС – начальный ток через индуктивность. 

Параметры модели индуктивности приведены в табл. 3.3. 
Таблица 3.3 

Параметры модели катушки индуктивности 

Параметр Коэффициенты Ед.изм. Значение  
по умолчанию 

L Масштабный – 1 

IL1 Линейный по току 1/А 0 

IL2 Квадратичный по току 1/А2 0 

ТС1 Линейный температурный 1/C 0 

ТС2 Квадратичный температурный 1/C2 0 

Описание модели индуктивности в общем случае имеет  следующий вид: 
.MODEL [Имя] IND <П1=ЗН1> <П2=ЗН2> .......  , 

где Имя –  имя модели; 
П1, П2… – наименования параметров; 

      ЗН1, ЗН2 … –  значения параметров. 
Параметрам, значения которых не указаны в описании модели, присваиваются 

значения по умолчанию. Если модель не задана, то значение индуктивности 
принимается  равным номиналу. Если модель задана явно, то значение индуктивности 
определяется по формуле 

L=(НоминалL)(1+IIL1+I2 IL2)[1+(T-T0) 2 TC2]. 
Задание начального тока через индуктивность позволяет уменьшить время расчета 

переходного процесса. 
LL0AD  15  0  20MH 

L1  2  3  LMOD  0.3 
Lbm2  4  7  Lmod 1m IC=0.1 
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3.3.4. Взаимные индуктивности (трансформаторы): 
Кимя Lxxx Lyyy Ксв, 

где    К – идентификатор взаимной индуктивности (трансформатора); 
          имя – обозначение элемента на схеме; 
          ххх, ууу – имена индуктивностей на схеме, между которыми имеется взаимная 
связь; 
          Ксв –коэффициент связи (-1<Ксв<1). 

Коэффициент связи можно определить, зная индуктивности катушек и их 
взаимную индуктивность, по формуле: 

2L1L
MKсв


 .  

Пример: 
KTR  L1  L2  0.1 
L1  2  3  1 
L2  5  6  0.5 

Примечание. Начало обмотки помещается в первый узел индуктивности. 
Полярность определяется только последовательностью узлов в описании 
индуктивностей и не зависит от порядка описания индуктивностей в записи «К». Если 
трансформатор состоит из нескольких обмоток, то в записях «К» нужно перечислить 
все взаимосвязанные пары.  

Например, трансформатор со средним отводом от первичной обмотки и с двумя 
вторичными обмотками описывается так: 

*Первичная   обмотка     *Взаимная     связь 
L1     1     2     100UH      K12    L1    L2     .9999  
L2     2     3     100UH      K13    L1    L3     .9999  
  
*Вторичная    обмотка    K14    L1    L4    .9999 
L3    11    12     100UH     K23    L2    L3     .9999  
L4    13    14     100UH     K24    L2    L4     .9999  
K34    L3    L4     .9999 
 
3.3.5. Магнитный сердечник трансформатора: 

Кимя Lxxx Lyyy Ксв <имя модели> <масштабный коэффициент>, 
где    Кимя – идентификатор сердечника; 
          имя – обозначение элемента на схеме; 
          ххх, ууу – имена индуктивностей, расположенных на сердечнике; 
          Ксв –коэффициент связи. 

Все обмотки имеют одинаковый коэффициент связи. При описании каждой 
обмотки, упомянутой в составе сердечника, необходимо указывать не  индуктивность, 
а число витков обмотки сердечника. Параметр <масштабный коэффициент> изменяет 
площадь поперечного сечения магнитопровода (по умолчанию равен единице), 
которая равна произведению этого коэффициента на параметр модели сердечника 
AREA. Параметры модели для LEVEL = 2 приведены в табл. 3.4. 
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Существуют два уровня этой модели: LEVEL = 1 и LEVEL = 2, из которых модель 
LEVEL = 1 оказалась неудачной и в последних версиях PSpice была исключена. В 
программе PSpice используется модель Джилса и Атерна, основанная на 
представлении движения доменных границ магнитных материалов. Она отражает 
следующие основные характеристики гистерезиса: кривую начальной 
намагниченности, намагниченность насыщения, коэрцитивную силу и остаточную 
намагниченность. 

Параметры AREA, PATH, GAP, PACK определяются геометрическими 
параметрами сердечника, остальные – свойствами магнитного сердечника. 

   

Таблица 3.4 
Параметры модели сердечника 

Параметр Описание Ед.изм. Значение по 
умолчанию 

LEVEL Индекс модели – 2 

A Параметр формы безгистерезисной 
кривой намагниченности А/м 1000 

AREA Площадь поперечного сечения 
магнитопровода см2 0.1 

C Постоянная упругого смещения 
доменных границ – 0.2 

GAP Ширина воздушного зазора см 0 

K Постоянная подвижности доменов А/м  500 

MS Намагниченность насыщения А/м 106 

PACK Коэффициент заполнения 
сердечника – 1 

PATH Средняя длина магнитной 
 силовой линии см 1 

Описание модели сердечника в общем случае имеет  следующий вид: 
.MODEL [Имя] CORE <П1=ЗН1> <П2=ЗН2> .......  , 

где Имя –  имя модели; 
П1, П2… – наименования параметров; 

      ЗН1, ЗН2 … –  значения параметров. 
 

3.3.6. Линии передачи: 
Тимя Х1+ Х2- Х3+ Х4- ZO <TD>  <F>  <NL> , 

где    Т – идентификатор линии передачи; 
   имя – обозначение элемента на схеме; 
   Х1, Х2 – узлы подключения на первой паре; 
   Х3, Х4 – узлы подключения на второй паре; 
   ZO –   характеристическое сопротивление; 
   TD –   время задержки в секундах; 
   F – частота в герцах; 
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   NL – длина волны на частоте F. 

Примечание. (+) и (-) вывода позволяют определить направление тока (от (+) к (-)). 
По умолчанию NL =0,25. 

TDELAY  15  0  16  0  ZO=5000HM  TD=0.2NS 
T33  4.2  3  5  ZO=220  F=2.25MEGHZ 

3.3.7. Идеальные управляемые ключи: 
S имя  N1  N2  N3+  N4-  [Имя модели], 

где S – идентификатор ключа; 
имя – обозначение элемента на схеме; 
N1, N2 – узлы подключения контактов ключа; 

  N3, N4 – положительный N3 и отрицательный N4 узлы подключения 
управляющего источника напряжения (тока). 

Параметры модели ключа приведены в табл. 3.5. 
Таблица 3.5 

Параметры модели управляемого ключа 

Параметр Значение параметра Ед.изм. Значение 
по умолчанию 

VON Напряжение открывания В –  

VOFF  Напряжение закрывания В –  

ION  Ток открывания А –  

IOFF Ток закрывания А –  

RON Сопротивление открытого ключа Ом 1 

ROFF Сопротивление закрытого ключа Ом 106 

Описание модели идеального ключа имеет следующий вид: 
.MODEL  [Имя]  [ТИП]  <П1=ЗН1>  <П2=ЗН2>  …. , 

где Имя – имя модели; 
ТИП –  один из следующих типов: 

VSWITCH – модель ключа, управляемого напряжением, 
       ISWITCH – модель ключа, управляемого током; 
П1, П2...–  наименования параметров; 
ЗН1, ЗН2...–  значения параметров. 
Параметрам, значения которых не указаны в описании модели, присваиваются 

значения по умолчанию. 
При напряжениях (токах), находящихся в диапазоне между порогом открывания и 

порогом закрывания, сопротивление ключа изменяется в пределах ROFF и RON. 
Сопротивление утечки по входу управления 1Е12 Ом. 

Sbw2  15  2  3  О  ТТТ  
.MODEL  ТТТ  VSWITCH  Von=2  Voff=l 
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3.3.8. Полупроводниковые диоды: 
D  имя  N+  N-  [Имя модели]    <area> , 

где D –   идентификатор диода; 
имя – обозначение элемента на схеме; 
N+ –  узел подключения положительного вывода диода (анода); 
N-  –  узел подключения отрицательного вывода диода (катода); 
Имя модели –  имя модели диода; 
area –  относительное значение площади прибора (по умолчанию 1,0). 
Параметры модели диода приведены в табл. 3.6. 

Таблица 3.6 
Параметры модели диода 

Параметр Описание Ед. изм. Значение 
по умолчанию 

AF 
 

Показатель степени в формуле 
фликкер-шума – 1 

BV 
 

Обратное напряжение пробоя  
(положительная величина) В ∞ 

CJO 
 

Барьерная емкость 
при нулевом смещении Ф 0 

EG 
 

Ширина запрещенной зоны эВ 1.11 

IBV 
 

Начальный ток пробоя, 
соответствующий 
напряжению BV  

(положительная величина) 

А 10-10 

IBVL 
 

Начальный ток пробоя  
низкого уровня А 0 

IKF 
 

Предельный ток при высоком 
уровне инжекции А ∞ 

IS Ток насыщения при Т = 27°С А 10-14 

ISR Ток рекомбинации А 0 

NR Коэффициент эмиссии для тока ISR – 2 

RS Объемное сопротивление Ом  0 

Окончание табл. 3.6. 

Параметр Описание Ед.изм. Значение по 
умолчанию 

TRS1 
 

Линейный температурный 
коэффициент RS 1/C 0 

TRS2 Квадратичный температурный 
коэффициент RS 1/оC2 0 

ТТ Время переноса заряда с 0 

VJ Контактная разность потенциалов В 1 

XTI Температурный коэффициент тока – 3 
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насыщения 

T_ABS Абсолютная температура оC 27 

T_MEASURED Температура измерений оC 27 

T_REL_GLOBAL Относительная температура оC 0 

T_REL_LOCL Разность между температурой 
диода и модели-прототипа 

оC 0 

 
Описание модели диода выглядит следующим образом: 

.MODEL [Имя] [Тип] <П1=ЗН1> <П2=ЗН2> ..., 
где Имя –  имя модели; 

Тип  –  D для плоскостного диода; 
П1, П2...–  наименования параметров; 
ЗН1, 3Н2...–  значения параметров. 

D1 14  0  DMOD 
.MODEL DMOD D 

3.3.9. Биполярные транзисторы: 
Qимя NC NB NЕ [Имя модели] <агеа>, 

 где Q –   идентификатор биполярного транзистора; 
имя –  обозначение элемента на схеме; 
NC, NB, NE – узлы подключения соответственно; коллектора, базы, эмиттера 

биполярного транзистора;  
Имя модели –  имя модели транзистора; 
area –  относительное значение площади прибора (по умолчанию 1,0). 
Примечание. При анализе по постоянному току используется модель Гумеля–Пунна, а в 

случае отсутствия ряда параметров этой модели используется модель Эберса–Молла.  
Описание модели биполярного транзистора выглядит следующим образом: 

.MODEL  [Имя]  [Тип]  <П1=ЗН1>  <П2=ЗН2> ...., 
где Имя –  имя модели; 

Тип –  один из следующих типов: 
NPN – модель транзистора с проводимостью n-типа,  
PNP – модель транзистора с проводимостью p-типа; 

П1, П2...–  наименования параметров; 
ЗН1, 3Н2...–  значения параметров. 
Параметрам модели биполярного транзистора приведены в таблице 3.7. 
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Таблица 3.7 
Параметры модели биполярного транзистора 

Параметр Описание Ед. изм. Значение 
по умолчанию 

AF 
 

Показатель степени  
в формуле фликкер-шума – 1 

BF 
 

Коэффициент передачи тока  
в нормальном режиме в схеме с ОЭ – 100 

BR Коэффициент передачи тока 
в инверсном режиме в схеме с ОЭ – 1 

CJC 
 

Емкость коллекторного перехода 
при нулевом смещении Ф 0 

CJE Емкость эмиттерного перехода 
при нулевом смещении пФ 0 

CJS Емкость коллектор-подложка при 
нулевом смещении Ф 0 

EG 
 

Ширина запрещенной зоны эВ 1.11 

FC 
Коэффициент нелинейности 

барьерных емкостей 
прямосмещенных переходов 

– 0,5 

IKF 
 

Ток начала спада зависимости BF 
от тока коллектора  

в нормальном режиме 
А ∞ 

IKR 
 

Ток начала спада зависимости BF от 
тока эмиттера в инверсном режиме А ∞ 

IRB 
Ток базы, при котором cопроти-

вление базы уменьшается на 50 % 
полного перепада между RB и RBM 

А ∞ 

IS Ток насыщения при Т = 27 °С А 10-15 

ISC Ток насыщения утечки перехода 
база-коллектор А 0 

ISE Ток насыщения утечки перехода 
база-эмиттер А 0 

ISS Обратный ток перехода подложки А 0 

KF 
Коэффициент, определяющий 

спектральную плотность фликкер-
шума 

– 0 

PTF Дополнительный фазовый сдвиг на 
граничной частоте транзистора град 0 

RB Объемное сопротивление базы при 
нулевом смещении база-эмиттер Ом 0 
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Окончание табл. 3.7.  

Параметр Описание Ед.изм. Значение 
по умолчанию 

RBM Минимальное сопротивление базы 
при больших токах Ом RB 

RC Объемное сопротивление коллектора Ом 0 

RE Объемное сопротивление эмиттера Ом 0 

TF Время переноса заряда через базу 
в нормальном режиме с 0 

TR Время переноса заряда через базу 
в инверсном режиме  с 0 

TRB1 Линейный температурный 
коэффициент RB 1/оC 0 

TRB2 Квадратичный температурный 
коэффициент RB 1/оC2 0 

TRC1 Линейный температурный 
коэффициент RC 1/оC 0 

TRC2 Квадратичный температурный 
коэффициент RC 1/оC2 0 

TRE1 Линейный температурный 
коэффициент RE 1/оC 0 

TRE2 Квадратичный температурный 
коэффициент RE 1/оC2 0 

TRM1 Линейный температурный 
коэффициент RM 1/оC 0 

TRM2 Квадратичный температурный 
коэффициент RM 1/оC2 0 

VAF Напряжение Эрли  
в нормальном режиме В ∞ 

VAR Напряжение Эрли 
в инверсном режиме В ∞ 

VJC Контактная разность потенциалов 
перехода база-коллектор В 0,75 

VJE Контактная разность потенциалов 
перехода база-эмиттер В 0,75 

VJS Контактная разность потенциалов 
перехода коллектор-подложка В 0,75 

VTF 
Напряжение, характеризующее 
зависимость TF от смещения 

база-коллектор 
В ∞ 

XTB Температурный коэффициент 
BF и BR – 0 

XTI Температурный коэффициент IS – 3 

T_ABS Абсолютная температура оC 27 

T_MEASURED Температура измерений оC 27 
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Пример:   Q1  14  2  13  KT3102A 
        .MODEL KT3102A NPN (BF=500) 

3.3.10. Полевые транзисторы с изолированным затвором 
(МОП-транзисторы) (MOSFET): 
М имя ND NG NS NB [Имя модели] <L=[valL]> <W=[valW]> +<AD=[valAD]> 

<AS=[valAS]> <PD=[valPD]> <PS=[valPS]> <NRD=[valNRD]> +<NRS=[valNRS]>, 

где М –  идентификатор МОП-транзистора; 
имя –  обозначение элемента на схеме; 

      ND, NG, NS –  узлы подключения соответственно стока, затвора, истока МОП - 
транзистора; 

NB –  узел подключения подложки; 
Имя модели –  имя модели транзистора; 
valL – длина канала (может устанавливаться пользователем); 
valW – ширина канала (может устанавливаться пользователем.); 
valAD – площадь стока, в метрах; 
valAS – площадь истока, в метрах; 
valPD – периметр стока, в метрах; 
valPS – периметр истока, в метрах; 
valNRD – относительное сопротивление стока; 
valNRS – относительное сопротивление истока. 

Описание модели МОП-транзистора в общем случае имеет вид 
.MODEL  [Имя]  [Тип]  <П1=ЗН1>  <П2=ЗН2> ...., 

где Имя – имя модели; 
       Тип –  один из следующих типов: 
          NMOS–модель МОП–транзистора с каналом n-типа, 
          PMOS–модель МОП–транзистора с каналом p-типа; 

П1,П2... – наименования параметров; 
      ЗН1,ЗН2... – значения параметров. Параметрам, не указанным в описании 

модели, присваиваются значения по умолчанию. 
Ml   14   2   13   0  PNOM  L=25U W=12U 
M2A 0 2 100 100 NW L=33U W=l2U AD=288P AS=288P PD=60U  

3.3.11. Полевые транзисторы с управляющим р-n-переходом: 
Jимя  ND  NG  NS [Имя модели] [area], 

где  J – идентификатор полевого транзистора с управляющим р-n-переходом; 
имя – обозначение элемента на схеме; 
ND, NG, NS – узлы подключения соответственно стока, затвора, истока полевого 

транзистора; 
Имя модели – имя модели транзистора; 
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area – относительное значение площади прибора (по умолчанию 1,0). 
Описание модели полевого транзистора с управляющим р-n-переходом в общем 

случае имеет следующий вид: 
.MODEL  [Имя]  [Тип]  <П1=ЗН1>  <П2=ЗН2> ... , 

где Имя – имя модели; 
Тип – один из следующих типов: 
   NJF – модель полевого транзистора с каналом типа n. 
   PJF – модель полевого транзистора с каналом типа р; 

  П1, П2... – наименования параметров;  
ЗН1, ЗН2... – значения параметров. Параметрам, не указанным в описании модели, 

присваиваются значения по умолчанию. 

J13   22. 14  23  JNOM  2.0 

 
3.3.12. Транзисторы на основе арсенида галлия (GASFET): 

В имя  ND  NG  NS  [Имя модели] < Коэфф. кратности area>, 
где В – идентификатор транзистора на основе арсенида галлия; 
     имя – обозначение элемента на схеме; 
     ND, NG, NS – узлы подключения соответственно стока, затвора, истока 
полевого транзистора; 

Имя модели – имя модели транзистора. 
Описание модели транзистора на основе арсенида галлия в общем случае имеет 

следующий вид: 
.MODEL  [Имя]  [Тип]  <П1=ЗН1>  <П2=ЗН2> .... 

где Имя – имя модели; 
Тип – GASFET-модель транзистора на основе арсенида галлия с каналом типа n; 
П1,П2... – наименования параметров; 
ЗН1,ЗН2... – значения параметров. Параметрам, не указанным в описании модели, 

присваиваются значения по умолчанию. 
BIN  100   1   О   GFAST 
В13   22   14   23  GNOM  2.0 

3.3.13. Независимые источники тока и напряжения: 
Vимя  N+ N-  <DC [ЗН1]>  <AС [ЗН2] <ФАЗА>>  <ТЗАК> <ПАРАМЕТРЫ> 
Iимя N+ N- <DC [3H1]>  <АС [ЗН2] <ФАЗА>>  <ТЗАК> <ПАРАМЕТРЬ1>, 

где V (I) – идентификатор источника напряжения (тока); 
имя – обозначение источника на схеме; 
N+, N- – соответственно положительный и отрицательный узлы подключения 

источника (ток течет от положительного узла через источник к отрицательному); 
DC – обозначение источника постоянного напряжения (тока); 
ЗН1 – номинальное значение источника в вольтах (амперах); 
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АС – обозначение источника переменного (синусоидального) напряжения (тока) 
для частотного анализа; 

ЗН2 – амплитуда сигнала в вольтах (амперах); 
ФАЗА – фаза переменной составляющей в градусах (если эта величина не задана, 

то она принимается равной нулю); 
ТЗАК – закон, по которому изменяется напряжение или ток источника во времени. 

Применяется при анализе переходного процесса. Может быть задан один из 
следующих законов: 

PULSE – для источника трапецеидальных импульсов; 
ЕХР – для источника экспоненциальных импульсов; 
SIN – для источника синусоидального напряжения; 
PWL – для кусочно-линейного источника; 
SFFN – для амплитудно-модулированного источника; 

ПАРАМЕТРЫ – параметры источника во временной области, задаются свои для 
каждого конкретного источника. 

3.3.13.1. Источник трапецеидальных импульсов: 
PULSE (V1 V2 TD TR TF PW PER) 
PULSE (I1  I2   TD ТR TF PW PER), 

где PULSE – идентификатор импульсного источника; 
V1 (I1) – постоянная составляющая, в вольтах (амперах); 
V2 (I2) – максимальное значение сигнала, в вольтах (амперах); 
TD – время задержки в секундах (по умолчанию равно 0); 
TR – длительность переднего фронта импульса, (по умолчанию равна TSTEP); 
TF – длительность заднего фронта импульса, в секундах (по умолчанию равна 

TSTEP); 
PW – длительность вершины импульса, в секундах (по умолчанию равна TSTOP); 
PER – период импульса, в секундах (по умолчанию равен TSTOP). 
Перечисленные параметры пояснены на рис. 3.2. 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 

TD TR TF PW 

T 

V1 

V2 

t 

V 

Рис. 3.2. Параметры источника трапецеидальных импульсов 
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Примечание. TSTEP – приращение времени при расчете переходного 
процесса; 

TSTOP – конечная временная точка при расчете переходного процесса. 
VIN  100  0  PULSE (0 5 0 0 0 1 2); источник прямоугольных импульсов с  
* амплитудой 5В, длительностью вершины 1с и периодом 2с 
VIN  100  0  PULSE (0 5 0 1 1 0 2); источник треугольных импульсов 

3.3.13.2. Синусоидальный источник: 
SIN (V1  V2  FC  TD  DF  PHASE), 

SIN (I1 I2  FC  TD  DF  PHASE), 
где SIN – идентификатор синусоидального источника; 

   V1(I1) – постоянная составляющая, В (А)  
   (обязательный параметр); 

   V2(I2) – максимальное значение сигнала, В (А)  
   (обязательный параметр); 

   FC – частота сигнала, в герцах (по умолчанию 1/STOP); 
   TD – задержка, в секундах (по умолчанию равна 0); 
   DF – декремент затухания, 1/с (по умолчанию равен 0); 
   PHASE – фаза, в градусах (по умолчанию равна 0). 

Примечание. При наличии затухания величина сигнала синусоидального 
источника определяется по формулам 

V(t)=V1+V2*EXP(–(T–TD)*DF)*SIN(2*PI*FC*(T–TD) – PHASE) . 
I(t)=I1+I2*EXP(–(T–TD)*DF)*SIN(2*PI*FC*(T–TD) – PHASE) 

 
VIN  100  0  SIN  (0  5  50)  
V1  5  4  SIN (0  25  1КНZ) 

3.3.13.3. Кусочно-линейный источник: 
PWL (T1 V1 T2 V2 ......TN VN), 
PWL (T1  I1  T2  I2 ...… TN IN), 

где  PWL – идентификатор кусочно-линейного источника; 
T1...TN – длительности интервалов; 
V1....VN (I1.... IN) – значения уровней сигнала по окончании соответствующего 

интервала. 
VIN 1 0 PWL (0 1 2N 1 3N 5 4N 10) 
3.3.13.4. Экспоненциальный источник: 

ЕХР (VI V2 TD TER TR TFR), 
ЕХР (I1  I2  TD TER TR TFR), 

где  ЕХР – идентификатор экспоненциального источника; 
VI (I1) – постоянная составляющая, вольт (ампер); 
V2(I2) – максимальное значение сигнала, вольт (ампер); 
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ТD –  время задержки (по умолчанию равно 0); 
TER –  постоянная времени нарастания переднего фронта, в секундах (по 

умолчанию равна TSTEP); 
   TR – постоянная времени начала спада заднего фронта,  в секундах (по умолчанию 
равна TD+TSTЕP); 

   TFR – постоянная  времени   спада,  в  секундах  (по умолчанию равна TSTEP). 
VIN 1 0 ЕХР (0 .2  2U 20U 40U 20U)  
I20  1 0 ЕХР (0 .2  2U 20U 40U 20U) . 

3.3.13.5. Амплитудно-модулированный источник: 
SFFM (VI V2 FC MOD FM), 
SFFM (I1  I2  FC MOD FM), 

где     SFFM – идентификатор амплитудно-модулированного источника; 
    V1(I1) – постоянная составляющая, вольт (ампер) (обязательный параметр); 
    V2(I2) – максимальное значение сигнала, вольт (ампер) (обязательный 

параметр); 
    FC – частота сигнала, в герцах (по умолчанию 1/STOP); 
    MOD – коэффициент амплитудной модуляции (по умолчанию равен 0); 
    FM – частота несущей, в герцах (по умолчанию 1/STOP). 
Величина сигнала модулированного источника в момент времени t определяется 

по формулам: 
V(t)=V1+V2*SIN((2*PI*FC*T)+MOD*SIN(2*PI*FM*T) 

  I(t) = I1 + I2*SIN((2*PI*FC*T)+MOD*SIN(2*PI*FM*T). 

VIN 1 0 SFFM (0 2 100MEGH 5 4КН)  
I20  1 0 SFFM (0 2МА 100MEG 5 4КH) 

3.3.14. Управляемые источники напряжения и тока. 
Нелинейные зависимые источники могут управляться от нескольких источников, 

и их значение определяется с помощью полинома. Полином для одного аргумента V1 
(одного источника) является 

V=a0+a1V1+a2V12+a3V23 +... 
Полином для двух аргументов V1, V2 (двух управляющих источников): 

V=a0+a1V1+a2V2+a3V12+a4V1V2+a5V22+a6V13+…  
Полином для трех аргументов V1,V2,V3 (трех управляющих источников): 

V=a0+a1V1+a2V2+a3V3+a4V12+a5V1V2+a6V1V3+a7V22+… 
3.3.14.1. Источники тока, управляемые напряжением: 

Gимя N+ N- <Vимя> <NY+> <NY-> [Крутизна] 
или  

Gимя N+ N- POLY(ND) <Vимя> <NY+> <NY-> [Значение коэффициента], 
где G – идентификатор источника тока, управляемого напряжением; 
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имя – обозначение элемента на схеме; 
N+, N- – соответственно  положительный и отрицательный узлы подключения 

источника тока; 
  Vимя – имя управляющего источника напряжения; управляющий источник 
напряжения должен быть независимым и не равным нулю; 

NY+, NY- – положительный и отрицательный узлы подключения управлявшего 
напряжения; 

Крутизна – крутизна источника; 
POLY – указывает на то, что управляемый источник описывается с помощью 

полинома; 
ND – число аргументов, входящих в полиномиальную зависимость; 
Значение коэффициента – коэффициенты полинома. 

GBUF 1 2 10 11 1.0 
GNON 100 101 POLY(2) 3 0 2 0 0.0 13.6 .2 005 
 

 
3.3.14.2. Источники тока, управляемые током: 

Fимя N+ N- <Iимя> <NY+> <NY-> [Значение] 
или  

Fимя N+ N- POLY(ND) <Iимя> <NY+> <NY-> [Значение коэф.], 
где F – идентификатор источника тока, управляемого током; 

имя – обозначение элемента на схеме; 
N+, N- – соответственно положительный и отрицательный узлы подключения 

источника тока ; 
Iимя – имя управляющего источника тока; ток, протекавший через управляющий 

источник, определяет выходной ток; управляющий источник тока должен быть 
независимым и не равным нулю; 

NY+, NY- – соответственно положительный и отрицательный узлы подключения 
источника управляющего тока; 

POLY – указывает на то, что управляемый источник описывается с помощью 
полинома; 

ND – число аргументов, входящих в полиномиальную зависимость; 
Значение – коэффициент пропорциональности; 
Значение коэф. – коэффициенты полинома. 

FSENS 1 2 VSENS 10.0  
FAMP 13 0 VIN 500  

 
3.3.14.3. Источники напряжения, управляемые током: 

Нимя N+ N- <Iимя> <NY+> <NY-> [Крутизна]  
или 

Нимя N+ N- POLY(ND) <Iимя> <NY+> <HY-> [Значение коэф.], 
где Н – идентификатор источника напряжения, управляемого током; 

имя – обозначение элемента на схеме; 
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N+, H- – соответственно положительный и отрицательный узлы подключения 
источника тока; 

Iимя – имя управляющего источника тока; ток, протекающий через управляющий 
источник, определяет выходной ток; управляющий источник тока должен быть 
независимым и  не равным нулю; 

Крутизна – крутизна источника; 
POLY – указывает на то, что управляемый источник описывается с помощью 

полинома; 
ND – число аргументов, входящих в полиномиальную зависимость; 
Значение коэф. – коэффициенты полинома. 

HSENS 1 2 ISENS 10.0  
HAMP 13 0 IN 500 
HNOLIN 100 101 POLY(2) ICNTRL1 ICNTRL2 0.0 13.6 .2 .005 

3.3.14.4. Источники напряжения, управляемые напряжением: 
Еимя N+ N- <Vимя> <NY+> <HY-> [Значение]  

или 
Еимя N+ N- POLY(ND) <Vимя> <NY+> <NY-> [Значение коэф.] , 

где  Е – идентификатор источника напряжения, управляемого напряжением: 
имя – обозначение элемента на схеме; 
N+, N- – соответственно положительный и отрицательный узлы подключения 

источника напряжения; 
Vимя – имя управляющего источника напряжения; управляющий источник 

напряжения должен быть независимым и не равным нулю; 
NY+, NY- – соответственно положительный и отрицательный узлы подключения 

управляющего источника; 
Значение – коэффициент пропорциональности; 
POLY – указывает на то, что управляемый источник описывается с помощью 

полинома; 
ND – число аргументов, входящих в полиномиальную зависимость; 
Значение коэф. – коэффициенты полинома. 

EBUF 1 2 10 11 1.0 
ENON 100 101 POLY(2) 3 0  4 0 1.1  0.0  13.6  2  9.65 0.003 

Примечания. 
1. Первая форма записи отражает линейную зависимость выходной величины от 
входной. Рассмотрим EBUF, здесь 1 и 2 – выходные узлы; 10 и 11 – управляющие 
узлы; 1.0 – крутизна; Vвых=1,0Vвх.  
2. Вторая форма записи отражает нелинейную зависимость выходной величины от 
входной. Рассмотрим ENON, здесь 100 и 101 – выходные узлы; POLY(2) – имеется 
два управляющих источника; 3 и 0 – узлы подключения первого управляющего 
источника V1; 4 и 0 – узлы подключения второго управляющего источника V2; 1.1, 
0.0, 13.6, 2, 9.65, 0.003 – коэффициенты полинома; при этом 

Vвых=1.1+0.0V1+13.6V2+2V1V1+9.65V1V2+0.003V2V2. 
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3.3.15. Подсхемы. 
Обращение к подсхеме в программе имеет следующий вид: 

   Х<имя> [узел]  [имя подсхемы], 
при этом должно иметься описание подсхемы в виде 

.SUBCKT  [имя] [Узел] 
 ……………………………….. 

.ENDS  
где SUBCKT – запись, описывающая подсхему; 

узел – узлы подключения подсхемы; 
Х – идентификатор подсхемы; 
Узел – узлы подключения подсхемы (для вложенной); 
.ENDS – оператор конца описания подсхемы. 
При вызове подсхемы запись [X . . . ] замещается описанием подсхемы. При 

вызове подсхемы номера узлов, указанные в вызывающей записи, замещают номера 
узлов, заданные при описании подсхемы. Уровень вложенности может быть любой, 
но нельзя допускать зацикливания, т.е. если подсхема А вызывает подсхему В, то из 
подсхемы В нельзя снова вызывать подсхему А.  

.SUBCKT OPAMP 1 2 101 102 
X1 1 2 4 UNITAMP 
.ENDS 
.SUBCKT UNITAMP 1 2 5  
R1 4 6 10К 
 ........... 
. ENDS 

3.4. Директивы управления 
Записи с директивами управления позволяют задавать требуемый вид анализа, его 

параметры, форму представления выходной информации и ряд величин, 
определяющих ход вычислительного процесса. Рассмотрим директивы управления 
более подробно. 
 

3.4.1. Директива [.TEMP]: 
.TEMP t1 <t2<t3...>> 

Директива [.TEMP] задает различные температуры t1,t2,t3,..., в градусах по Цельсию, 
для каждой из которых производится моделирование схемы. Величина t1, меньшая -
223 градусов, игнорируется. Параметры моделей задаются при номинальной 
температуре, которая может быть изменена заданием директивы [.OPTIONS] с опцией 
TNOM. Если директива [.TEMP] отсутствует, то моделирование проводится при 
температуре, равной номинальной. 

.TEMP  -27  0  27 

.TEMP  -55.0   25   155.5 
3.4.2. Директива [.NODESET]  

.NODESET  V(Номер узла) = [Напряжение] <...> 
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Данная директива позволяет задать начальные напряжения перечисленных в ней 
узлов для анализа по постоянному току и расчета переходных процессов. Она должна 
применяться при моделировании схем с двумя и более устойчивыми состояниями для 
улучшения сходимости расчета по постоянному току и выбора правильной рабочей 
точки. Применение директивы [.NODESET] при расчете схем с одним устойчивым 
состоянием позволяет в ряде случаев снизить затраты машинного времени на 
моделирование и не влияет на окончательную рабочую точку. 

.NODESET  V(22) = 2.1  V(100) = 0   V(5) = -12 

.NODESET  V(11) = -5.5V   V(100) = 100  V(5) = -1V 
3.4.3. Директива [.IС]:  

.IС V(Номер узла)=[Напряжения] <...> 
Директива [.IС] задает начальные условия при расчете переходных процессов для 

перечисленных в ней узлов. В зависимости от опции [UIС] в директиве [.TRAH] 
директива [.IС] может иметь различное действие: 

 а) при задании опции [UIC] в директиве [.TRAN] значения узловых напряжений, 
определенных в директиве [.IС], используются при расчете начальных условий в 
моделях емкости, диода, транзисторов, что эквивалентно заданию опции [IС=...] в 
каждом описании модели полупроводникового прибора, но в более удобной форме. 
При одновременном задании директивы [.IС] и опции [IС=...] принимается значение, 
указанное в опции. В директиве [.IС] должны быть обязательно заданы напряжения на 
всех источниках постоянного тока, определяющих начальные условия для 
полупроводниковых приборов; 

б) если опция [UIC] в директиве [.TRAN] не задана, то перед моделированием 
определяется рабочая точка  схемы по постоянному току, т.е. директива [.1С] не 
оказывает влияния на результат моделирования.  

.IС  V(22)=2.1  V(102)=0   V(3)= -12 

.IС  V(11)= -22.3 V(102)=100  V(3)= -1V 
3.4.4. Директива [.OP]:  

.OP 
При задании директивы [.OP] программа проводит анализ схемы по постоянному 

току. При этом индуктивности представляются в виде короткого замыкания, емкости 
закорачиваются. Данный вид анализа позволяет рассчитать токи активных элементов, 
рассеиваемые мощности всех источников напряжения. Определяются также 
линеаризованные параметры всех нелинейных управляемых источников и 
полупроводниковых элементов. При отсутствии этой директивы рабочие точки все 
равно рассчитываются, но в выходной файл выводится лишь список узловых 
напряжений. 

Пример:  .OP 
 

3.4.5. Директива [.DC]: 
.DC [Имя источника]  VB1  VE1  VS1 <[Имя источника]  VB2 VE2 VS2> 

Директива [.DC] определяет источник напряжения или тока, для которого 
рассчитываются характеристики схемы по постоянному току, а также задает пределы 
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изменения и шаг при построении передаточных характеристик схемы. В программе 
предусмотрен расчет передаточных характеристик при одновременном изменении 
параметров двух источников. В этом случае сначала будет изменяться значение 
параметра первого источника при каждом значении параметра второго источника, что 
используется при расчете вольт-амперных и выходных характеристик 
полупроводниковых приборов. 

Опции директивы [.DC] означают: 
VB1,VB2 – начальные напряжения или токи источников; 
VE1,VE2 – конечные напряжения или токи источников; 
VS1,VS2 – соответствующие приращения. 
.DC  VIN  0.25  2.2  0.1 
.DC  VDS  0 10  0.5  VGS   0 5  1 
.DC  VCE  0 10  0.25  IB  0  10u  lu 

3.4.6. Директива [.TF]:  
.TF [Выходная величина] [Входной источник] 

Директива позволяет рассчитать на постоянном токе в режиме малого сигнала в 
зависимости от типов входного источника и выходной величины следующие 
характеристики: 

1) передаточную характеристику по току или напряжению; 
2) входное сопротивление; 
3) выходное сопротивление. 
.TF  V(10.2)  VIN  
.TF  I(VS)  VIN 

3.4.7. Директива [.TRAN]:  
.TRAN</OP>  TS  ТЕ  <ТВ  <ТМАХ>  <UIC> 

Директива [.TRAN] позволяет проводить расчет переходных процессов, при этом: 
 TS – величина шага при выводе таблиц и графиков; 
 ТЕ – время окончания расчета переходных процессов; 
 ТВ – начало переходного процесса (по умолчанию ТВ=0). В интервале времени 

[0,ТВ] расчет переходных процессов все равно производится для определения 
начальных условий, однако результаты расчета не запоминаются. 

ТМАХ – максимальный шаг интегрирования. По умолчанию ТМАХ равен 
наименьшему из двух величин: TS либо (ТЕ–ТВ)/50.  

Опция [/ОР] используется для вывода значений рабочей точки схемы.  
Опция [UIC] позволяет использовать в качестве начальных условий значения 

параметров [IC=...], заданных при описании элементов схемы. 
.TRAN  1ns  100ns 
 .TRAN/OP  1ns 1000ns l00n 
 .TRAN  1  100  UIC 

3.4.8. Директива [.AC]: 
.AC  DEC  ND FB FE 
.AC  LIN  NP  FB FE 
.AC  OCT NO FB FE 
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Директива определяет расчет электронной схемы по переменному току и 
позволяет выполнить анализ ее характеристик в заданном диапазоне частот. В схеме 
обязательно должен быть один независимый источник с параметром [АС].  

Опции в директиве [.АC] означают: 
DEC – изменение частоты по декадам; 
ND – число точек в декаде; 
LIN – линейное изменение частоты; 
NP – число точек в диапазоне; 
ОСТ – изменение частоты по октавам; 
NO – число точек в октаве; 
FB – начальная частота анализа; 
FE – конечная частота анализа. 
.AC  DEC  10  1  10000  
.AC ОСТ 10 10 100К  
.AC LIN 100 1K 10MEG 

3.4.9. Директива [.FOUR]:  
.FOUR [Частота основной гармоники] [Выходные переменные] 

Директива предназначена для проведения Фурье-анализа и соответственно 
определения гармонических составляющих выходного сигнала. При этом 
вычисляются амплитуды и фазы гармонических составляющих, а также их величины, 
отнесенные к амплитуде и фазе первой гармоники. 

Директива [.FOUR] работает только совместно с директивой [.TRAN], число 
рассчитываемых гармоник равно 9. 
 

.FOUR 10K  V(12) V(13)  I(IVIN) 

.FOUR 50HZ  V(5) V(7) 
3.4.10. Директива [.SENS]:  

.SENS [Выходная переменная] <[Выходная переменная]> 
При наличии директивы [.SENS] производится анализ чувствительности на 

постоянном токе для всех перечисленных выходных переменных по отношению к 
каждому из параметров схемы. 

.SENS  V(15)  V(16.2)  V(22)  

.SENS  V(2)   I(VCC) 
3.4.11. Директива [.NOISE]:  

.NOISE  [Выходная переменная]  [Входной источник] 
Директива [.NOISE] предназначена для расчета шумовых характеристик и 

используется совместно с директивой [.AC]. Программа рассчитывает шумы для 
заданной выходной переменной, эквивалентные шумы, приведенные ко входному 
источнику, выводит таблицу весовых коэффициентов для каждого источника шумов в 
рамках частотного диапазона, определяемого параметром NSUM. Если NSUM=0, то 
таблица не выводится. 
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3.4.12. Директива [.PLOT]: 
.PLOT [DC]  [AC]  [NOISE] [TRAN]  [ВыхПер] [НП]  [ВП] 

Директива предназначена для представления результатов расчета в виде таблиц и 
графиков, формируемых с помощью текстовых символов в файле *.out.  

Опции директивы: 
[DC], [AC], [NOISE], [TRAN] – вид анализа, для которого выводится выходная 

информация; 
[ВыхПер] – выходные переменные, для которых строится таблица и графики; 
[НП] – нижний предел; 
[ВП] – верхний предел. 
При построении графика в программе автоматически определяются максимальная 

и минимальная величины выходных переменных и происходит масштабирование осей 
координат так, чтобы график подходил под эти размеры. Однако масштабированием 
можно управлять, если указать пределы осей координат. На один график 
одновременно можно вывести до 8 переменных. 

.PLOT  DC  V(3)  V(2.3)  V(R1)  I(VIN)  I(R2)  IB(Q3) VBE(Q3)  

.PLOT  AC  VM(2)  VP(2)  VM(3,4)  VG(5) VDB(5)  IR(6)  II(6)  

.PLOT  NOISE   INOISE   ONOISE   DB(INOISE) DB(ONOISE) 

.PLOT  TRAN  V(3)  V(2,3)  (0,5V)  ID(M2)   I(VCC) (-50MA,50MA) 
3.4.13. Директива [.PROBE]: 

.PROBE [Выходные переменные] 
 Директива предназначена для передачи данных в графический постпроцессор 
Probe и запуска последнего на исполнение. В результате выполнения директивы 
появляется возможность просмотра результатов моделирования в графическом виде. 
Если выходные переменные не указаны, то в дальнейшем в окне (см. рис. 2.13) 
возможно отобразить все токи, напряжения, мощности для данной схемы. В 
противном случае возможен только выбор из указанных выходных переменных.  

.PROBE 

.PROBE V(1) I(R) 
3.4.14. Директива [.LIB]: 

.LIB [Имя библиотеки] 
 Директива служит для подключения библиотеки моделей компонентов. 

.LIB NOM.LIB 

.LIB C:\PSPICE\MYLIB.LIB 
 

4. СОЗДАНИЕ ПОЛЬЗОВАТЕЛЬСКИХ БИБЛИОТЕК 
 Для полноценной работы в среде Orcad необходимо наличие библиотек, 
содержащих используемые разработчиком элементы. Многие библиотеки с 
описаниями зарубежных элементов, разработанные фирмами-производителями, 
можно найти с помощью Internet. К сожалению, отечественные производители не 
обеспечивают поддержку своих изделий в системах автоматизированного 
проектирования, поэтому при проектировании приходится либо использовать 
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зарубежные аналоги, либо создавать свои библиотечные элементы.  
 Для создания библиотечного элемента, пригодного для моделирования с 
помощью программы Capture, необходимо: 
 1. Создать модель, описывающую функционирование элемента, в соответствии 
с соглашениями программы PSpice. 
 2. Создать условное графическое обозначение (УГО) элемента. 
 3. Связать УГО и модель в единый библиотечный элемент. 
 При необходимости дальнейшей разработки печатной платы необходимо также 
разработать чертеж посадочного места элемента и внедрить его в библиотечный 
элемент. 

4.1. Создание моделей элементов 
 В зависимости от вида описываемого устройства все множество моделей можно 
разделить на два вида: 
 1. Модели, имеющие встроенное описание на языке PSpice. При этом для 
создания пользовательской модели необходимо задать необходимые параметры. 

Пример: 
.MODEL D_MY D VJ=0.75 

 2. Модели, описываемые с помощью подсхем. Модель содержит описание 
электрической схемы устройства, а также набор параметров, значения которых 
задаются при использовании модели либо принимаются равными значениям по 
умолчанию. 

Пример: 
.SUBCKT MY_CIR IN OUT AGND 

  + PARAMS: C1VAL=1 C2VAL=1 R1VAL=1 R2VAL=1 GAIN=10000 
  C1 IN N1 {C1VAL} 
  C2 N1 OUT {C2VAL} 
  R1 IN N1 {R1VAL} 
  R2 N1 OUT {R2VAL} 
  EAMP1 OUT AGND VALUE={V(AGND,N1)*GAIN} 

      .ENDS 
 Файлы с описаниями моделей имеют расширения *.mod (содержит только одну 
модель) или *.lib (содержит как одну, так и целую библиотеку моделей) и 
представляют собой текстовые файлы, которые в принципе могут создаваться в 
любом текстовом редакторе. 
 При создании моделей первого вида удобно пользоваться программой PSpice 
Model Editor, входящей в состав пакета Orcad, которая по паспортным данным 
рассчитывает параметры моделей полупроводниковых приборов (диодов, 
биполярных, полевых, статически индуцированных биполярных транзисторов, 
мощных МОП транзисторов, транзисторов Дарлингтона, макромоделей 
операционных усилителей, компараторов напряжения, регуляторов напряжения, 
стабилизаторов напряжения и моделей магнитных сердечников). Отметим, что Orcad 
9.2 Lite Edition позволяет рассчитать только модели диодов. 
 В качестве примера работы с программой PSpice Model Editor рассчитаем 
параметры модели полупроводникового диода. Сначала по команде FileOpen 
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указывается имя файла библиотеки моделей диодов (если такого файла не существует, 
то создается новый файл с расширением .lib по команде FileNew). Далее по команде 
ModelNew вводится имя модели диода и в предлагаемом списке типов моделей 
указывается его тип Diode (рис. 4.1). 
 
 
 
 
 
 
 
 
 
 
 

Рис. 4.1. Окно выбора типа модели 
 
 
 

Рис. 4.1. Окно выбора типа модели 
После ввода имени и типа модели на экран выводится список параметров модели 

(рис. 4.2). В левой части экрана приведен перечень моделей в данной библиотеке, в 
правой – перечень вводимых паспортных данных параметров математической модели 
и их графическое отображение, в нижней части окна выводится перечень параметров 
математической модели, рассчитанной на основе введенных паспортных данных. 
Первоначально всем параметрам модели присваиваются значения по умолчанию. 
Паспортные данные вводятся порциями, соответствующими различным режимам 
работы компонента.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 4.2. Окно редактирования модели 
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Вводимые данные при нажатии соответствующей кнопки (ввод команды Extract) 
немедленно отображаются графически. На основании порции введенных данных по 
команде Extract рассчитывается ряд параметров математической модели, значения 
которых отображаются  в окне Parameters (см. рис. 4.2). Редактирование значений 
отдельных рассчитанных параметров математической модели выполняется после 
щелчка в соответствующем окне. По команде PlotAdd Trace возможно построить 
семейство характеристик при вариации температуры или других параметров модели. 
По умолчанию предлагается построить графики характеристик при изменении 
температуры. Имя варьируемой переменной изменяется по команде PlotAxis 
Settings. Например, для диодов возможна вариация параметров IS, N, RS, IKF, EG и 
XTI. 

Построение модели завершается командой записи обновленных данных в 
библиотечный файл FileSave. 
 PSpice Model Editor позволяет также редактировать и создавать модели второго 
вида (в виде подсхем), однако редактирование происходит в текстовом виде и не 
имеет преимуществ перед обычным текстовым редактором. 
 Для создания сложных моделей второго вида можно рекомендовать 
использование программы Capture. При этом сначала создается принципиальная 
схема, на которой помещаются иерархические порты, указывающие вход и выход 
(например приведенная на рис. 4.3, а). После этого необходимо создать файл, 
содержащий описание подсхемы. Для этого необходимо активизировать окно 
менеджера проекта, после чего из появившегося пункта меню Tools выбрать подпункт 
Create Netlist. В появившемся окне перейдем на вкладку PSpice и выберем в разделе 
Options пункт Create SubCircuit Format Netlist (рис. 4.3, б). После выбора места 
сохранения и имени файла нажмем кнопку OK – и наша модель готова. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 4.3. Этапы создания модели второго вида 
 

4.2. Создание законченного пользовательского элемента 
 Рассмотрим создание законченного библиотечного элемента на примере 
разработки ключа, замыкаемого в определенный момент времени.  
 1. Разработаем модель ключа, для чего создадим текстовый файл, описывающий 
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наше устройство с использованием источника трапецеидальных импульсов и ключа, 
управляемого напряжением: 
 .SUBCKT  Switch  1  2  PARAMS: 

+ tClose=0; момент замыкания ключа 
+ ttran=1u; время срабатывания ключа 
+ Rclosed=0.01; сопротивление в закрытом состоянии 
+ Ropen=1Meg ; сопротивление в открытом состоянии 
V1 3 0 pulse(0 1 {tClose} {ttran} 1 10k 11k) 
S1 1 2 3 0 Smod 
.model Smod Vswitch(Ron={Rclosed} Roff={Ropen}) 
.ends 

 Сохраним полученный файл под именем Switch.lib. 
 2. Запустим программу PSpice Model Editor. В меню File выберем пункт Create 
Capture Parts. В появившемся окне (рис. 4.4) в строке Enter Input Model Library укажем 

файл, содержащий созданную модель 
(C:\Switch\Switch.LIB), при этом в строке Enter 
Output Part Library появится предлагаемое 
название файла с описанием создаваемого 
элемента (C:\Switch\Switch.olb), с чем мы 
согласимся, нажав кнопку ОК. После этого будет 
создан файл библиотеки Switch.olb. Отметим, что 
аналогичный результат можно получить с 
помощью программы Capture, для чего 
необходимо в меню Tools выбрать пункт Generate 

Part. При этом также происходит обращение к программе PSpice Model Editor, однако, 
без появления оконного интерфейса последней. Генерация элементов по умолчанию 
происходит на основе библиотеки C:\Program Files\OrcadLite\Capture\ Library\ 
PSpice\modeled.etc. При необходимости изменения этой установки нужно в меню 
программы PSpice Model Editor выбрать пункт ToolsOptions и изменить пункт Base 
Part On. 
 3. В программе Capture откроем библиотеку Switch.olb (FileOpen 
LibrarySwitch.olb). В появившемся окне менеджера проекта дважды щелкнем на 
названии элемента Switch, после чего появится окно с изображением символа 
элемента, представленное на рис. 4.5, а. Пунктирная линия очерчивает границы 
элемента, которые легко изменяются с помощью мыши. При использование элемента 
в схеме граница не изображается. С помощью панели инструментов, расположенной 
справа в главном окне, нарисуем условное графическое обозначение ключа. В 
результате получим УГО, представленное на рис. 4.5, б. 
 
 
 
 
 
 
 

Рис. 4.4. Окно создания элемента в 
программе PSpice Model Editor 
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Рис. 4.5. Окно с изображением УГО элемента 

 

   
 
 
 
 
 
 

Дважды щелкнем левой кнопкой мыши на белом поле окна рис. 4.5, б. В 
результате появится окно User Properties (рис. 4.6). Сделаем невидимыми номера 
узлов, для чего щелкнем на строчке Pin Number Visible, после чего в нижней части 
окна рис. 4.5 изменим значение с True на False. Сделаем видимым параметр TCLOSE, 
для чего дважды щелкнем левой кнопкой мыши на строчке TCLOSE, после чего в 
появившемся окне Display Properties (рис. 4.7) в группе Display Format активизируем 
переключатель Name and Value.  

При необходимости таким же образом можно сделать видимыми сопротивления 
ключа в открытом и закрытом состояниях и другие параметры. 
Закроем окно User Properties, нажав кнопку ОК.  

Графическое изображение получившегося элемента приведено на рис. 4.8.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Сохраним библиотеку, выбрав пункт Save меню File. Создание пользовательского 
библиотечного элемента закончено.  
 Проверим функционирование нашего элемента, для чего создадим новый 
проект и соберем схему, представленную на рис. 4.9. На рис. 4.10 а, б приведены 
соответственно графики выходного напряжения при значениях параметра TCLOSE, 
равных 0 и 5с. 
 
 

Рис. 4.6. Окно User Properties 

Рис. 4.7. Окно Display Properties 

Рис. 4.8. Графическое изображение 
элемента Би
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По рис. 4.10 мы видим, что созданный библиотечный элемент функционирует 
правильно, т.е. замыкание ключа происходит в заданный момент времени. Небольшое 
прохождение входного сигнала на выход при разомкнутом контакте обусловлено 
наличием сопротивления Ropen, которое мы приняли равным 1МОм. Увеличение 
этого сопротивления приближает созданный элемент к идеальному. 

Единственным недостатком созданного элемента является то, что он имеет 
позиционное обозначение U, что не соответствует принятому стандартному 
обозначению ключевого элемента S. Для исправления этого недостатка вновь откроем 
библиотеку с нашим элементом, для чего в программе Capture в меню выберем 
пункты FileOpenLibrarySwitch.olb. Затем выберем пункты меню 
OptionsPackage Properties. В появившемся окне Edit Part Properties в поле Part 
Reference Prefix заменим U на S. 

Если при использовании пользовательского элемента в схеме программа Capture 
не может найти созданную библиотеку с моделью элемента и выдает 
соответствующее сообщение об ошибке (например ERROR – Subcircuit Switch used by 
X_S1 is undefined), то необходимо открыть окно редактирования профиля 
моделирования (см. рис. 2.12), перейти на закладку Libraries, указать в строке 
Filename имя и путь к библиотеке, после чего либо сделать созданную библиотеку 
глобальной (доступной всем проектам), нажав кнопку Add As Global, либо добавить 
ее только к созданному проекту, нажав кнопку Add to Design (рис. 4.11). 

 
 
 
 
 
 
 
 
 

 
 
 

Рис. 4.9. Схема для проверки 
функционирования элемента 

Рис. 4.10. Графики выходного напряжения 

а 
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Рис. 4.11. Объявление созданной библиотеки в качестве глобальной 
 
 Рассмотрим второй путь создания библиотечного элемента, при котором файл 
*.olb не генерируется в автоматическом режиме, а создается вручную. 

1. Разработаем модель ключа так же, как это было сделано выше.  
2. Запустим программу Capture и создадим новую библиотеку (FileNew 

Library). Присвоим новой библиотеке имя Switch2.olb, для чего сохраним ее под этим 
именем командой Save As. Создадим новый элемент, для чего выделим в менеджере 
проекта заголовок библиотеки одним щелчком левой кнопкой мыши, затем щелкнем 
правой кнопкой и выберем пункт New Part (рис. 4.12). В результате появится окно 
New Part Properties (рис. 4.13). 

В графе Name данного окна укажем имя элемента (Switch). В графе Part Reference 
Prefix необходимо указать обозначение элемента на схеме (например для резистора – 
R, конденсатора – С и т.д.). Для ключа выберем стандартное обозначение S. В графе 
PCB Footprint указывается посадочное место, которое будет использоваться при 
разработке печатной платы. Так как в дальнейшем не предполагается использовать 
наш элемент для разработки печатной платы, то оставим эту графу пустой. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Переключатель Create Convert View предназначен для создания альтернативного 
изображения элемента (если существуют несколько вариантов принятых 
обозначений).  

Раздел Multiple-Part Package предназначен для указания количества элементов в 
одном корпусе, при этом элементы могут быть как однотипными (Homogeneous), 
например, все элементы – инверторы, так и разнотипными (Heterogeneous), например 
кроме инверторов в корпус входят также элементы ИЛИ.  

 
Раздел Part Numbering позволяет указать способ нумерации элементов: 

Alphabetic – буквенный, Numeric – числовой.  

Рис. 4.12. Создание нового элемента Рис. 4.13. Окно New Part Properties 
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 Кнопка Part Aliases позволяет присвоить элементу один или несколько 
псевдонимов, что позволяет уменьшить размер библиотеки за счет использования 
одного библиотечного элемента для описания различных приборов с одинаковым 

функциональным назначением (например: 
К164ЛА7, К561ЛА7, К1564ЛА7). 
 Кнопка Attach Implementation позволяет 
добавить описание, в том числе модель для 
программы PSpice (рис. 4.14). В графе 
Implementation укажем имя модели Switch.  

После добавления модели закроем окно рис. 
4.13, нажав кнопку ОК. 

 
 

В результате получим окно редактирования элемента (рис. 4.15).  
 Добавим выводы элемента, нажав кнопку Вывод (Place Pin) (см. табл. 2.3) 
панели инструментов. При этом появится окно, показанное на рис. 4.16.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Рассмотрим назначение полей: 
Name – имя узла. Может быть как цифровое, так и буквенное. При необходимости 

ввода имени с чертой вверху, нужно после каждой буквы поставить слэш (например 
R\E\S\E\T\). 

Number – номер узла (можно не указывать). 
Width – тип вывода. Если вывод соединен с одиночным проводником, 

необходимо выбрать Scalar, при соединении вывода с шиной – Bus. 
Shape – вид графического изображения вывода: 
     – Line; 

  –  Dot; 
– Clock; 

   – Dot-Clock; 
  
– Zero; 
  

Рис. 4.14. Создание связи 
с PSpice моделью 

Рис. 4.16. Окно создания вывода 
элемента 

Рис. 4.15. Окно редактирования 
элемента 
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– Short; 
Type – тип вывода по функциональному назначению: 

  3-state – вывод с тремя состояниями (низкий уровень, высокий уровень, 
высокоомное состояние); 
  Bidirectional – двунаправленный вывод (вход-выход); 
  Input – вход; 
  Output – выход; 

Open collector – открытый коллектор; 
  Open emitter – открытый эмиттер; 
  Passive – пассивный вывод. Пассивный вывод обычно используется в 
устройствах,  не содержащих источников энергии (например такие выводы имеет 
резистор). 
 Power – вывод питания или земли. 

Переключатель Pin Visible позволяет отобразить или убрать изображение выводов 
питания. 

Кнопка User Properties отображает соответствующее окно, позволяющее указать 
дополнительные свойства вывода, а также произвести редактирование 
существующих. 
 Добавим два пассивных вывода в форме линии (Line) с именами 1 и 2. После 
этого нарисуем графическое изображение ключа так же, как это было сделано выше.  
 В отличие от первого варианта создания библиотечного элемента шаблон 
PSpiceTemplate, необходимый для моделирования с помощью программы PSpice, 
автоматически не создается. Поэтому  добавим его вручную, для чего, дважды 
щелкнув левой кнопкой мыши на белом фоне, перейдем в окно User Properties (см. 
рис. 4.6). Нажмем кнопку New, в поле Name введем имя PSpiceTemplate, в поле Value 
введем значение (структура приведенного описания будет пояснена ниже): 
 X^@REFDES %1 %2 @MODEL PARAMS:  ?TCLOSE|TCLOSE=@ TCLOSE|| 
TCLOSE=0|?TTRAN|TTRAN=@TTRAN||TTRAN=1U|?RCLOSED|RCLOSED=@RCLO
SED||RCLOSED=0.01|?ROPEN|ROPEN=@ROPEN||ROPEN=1MEG|, 
затем нажмем кнопку ОК. 

Аналогично создадим параметры TCLOSE, TTRAN, 
RCLOSED, ROPEN, сделав параметр TCLOSE видимым. 
 Окончательный вид получившего элемента приведен 
на рис. 4.17.  

Для проверки правильности функционирования 
созданного элемента включим его в схему рис. 4.9. После 
моделирования получим те же графики, что и ранее (см. рис. 
4.10), что подтверждает работоспособность нового 
элемента. 
 Наиболее сложным этапом при втором способе 
создания элемента является написание шаблона 

PSpiceTemplate. Рассмотрим структуру этого шаблона более подробно. 
Шаблон состоит из списка атрибутов. Атрибуты, состоящие из стандартных 

символов, копируются в список соединений без изменений. Стандартные символы 
состоят из алфавитно-цифровых символов, знаков «$»,«_», пробелов и знаков 

Рис. 4.17. Окончательный 
вид элемента 
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пунктуации. Если перед именем атрибута помещен специальный знак «@», «?», «~», 
«#» или «&», то в зависимости от его вида атрибуты шаблонов заменяются 
следующими величинами: 

@<имя> — значением атрибута <имя>. В отсутствие указанного атрибута или его 
значения выдается сообщение об ошибке; 

&<имя> — значением атрибута <имя>, если этот атрибут определен; 
?<имя>s...s — заменяется текстом, помещенным между одинаковыми символами 

s, если атрибут определен; 
~<имя>s...s — заменяется текстом, помещенным между одинаковыми символами 

s, если атрибут не определен; 
#<имя>s...s — производятся те же действия, что при наличии знака «?», но 

остальная часть шаблона удаляется, если <имя> не определено. 
Символы s, ограничивающие текст, могут быть любыми неалфавитными 

символами (сами они в список соединений не переносятся), наиболее часто 
используются следующие: « . », « , », « / », « | ». 

 Внутри этого текста допускается вложение, т.е. размещение атрибутов, 
предваряемых специальными знаками. 

Знак «ˆ» также специальный. Он заменяется указанием полного пути доступа к 
компонентам, имеющим иерархическую структуру. Для компонентов, находящихся 
на высшем уровне иерархии, в списке соединений этот знак заменяется знаком 
подчеркивания «_». 

Последовательность знаков «\n» приводит к переходу на следующую строку 
в списке соединений. Так что шаблон PSpiceTemplate, который размещается на одной 
строке, практически не ограниченной длины, в списке соединений может быть 
размещен на нескольких строках. Кроме того, таким способом в шаблоне 
PSpiceTemplate можно описать подключение к основному компоненту ряда 
дополнительных (например, учесть сопротивление потерь катушки индуктивности и 
т.п.). 

Имена выводов в шаблоне предваряются знаком «%». Имена выводов символов 
перечисляются в шаблоне в том порядке, в котором они должны быть записаны для 
каждого компонента по правилам PSpice. В списке соединений они замещаются 
именами цепей, к которым они подсоединены на схеме. В шаблоне под именем 
вывода понимаются все символы, расположенные между символом «%» и первым 
разделителем (пробелом или запятой). 

В шаблоне PSpiceTemplate имена компонентов в списке соединений должны 
начинаться с префикса, обозначающего их тип (R – резистор, Q – биполярный 
транзистор, Х – подсхема и т.п.).  
 В качестве примера рассмотрим шаблон резистора, имеющего два узла (1 и 2) и 
два требуемых свойства: REFDES и VALUE.  

Запишем шаблон PSpiceTemplate:  
R^@REFDES %1 %2 @VALUE. 

При использовании такого резистора в схеме список соединений (Netlist) может 
иметь вид R_R15 23 0 10К; при этом REFDES равно R15, VALUE равно 10К, резистор 
включен между 23 и 0 узлами. 
 Рассмотрим шаблон подсхемы Z, имеющей два узла (a и b) и изменяемый 
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параметр подсхемы G, по умолчанию равный 1000:  
X^@REFDES %a %b Z PARAMS: ?G|G=@G|~G|G=1000|. 

 Данный шаблон может быть записан и в форме (если … то) 
X^@REFDES %a %b Z PARAMS: ?G|G=@G||G=1000|. 

 При использовании подсхемы в схеме список соединений может иметь 
следующий вид: 
 при указании значения G, равном 150: 

X_U3 25 11 Z PARAMS: G=150; 
 при отсутствии указания значения G: 

X_U3 25 11 Z PARAMS: G=1000. 
 
 

4.3. Создание пользовательских символов 
 К символам в программе Orcad относятся: символы земли и питания (Power), 
межстраничные соединители (Off-Page Connector), иерархические порты (Hierarchical 
Port) и основные надписи (Title Block). Набор символов, поставляемых с программой 
Orcad, находится в библиотеке по адресу C:\Program 
Files\OrcadLite\Capture\Library\capsym.olb. К сожалению, не все из них соответствуют 
требованиям отечественных стандартов, поэтому возникает необходимость 
редактирования существующих и создания оригинальных пользовательских 
символов. 
 Наиболее актуальной задачей является создание основных надписей, поэтому 
рассмотрим данных процесс более подробно.  

 Создадим новую библиотеку, для чего в 
программе Capture выполним пункты меню 
FileNewLibrary. В появившемся окне 
менеджера проекта щелкнем правой кнопкой 
мыши на названии библиотеки и выберем пункт 
New Symbol (см. рис. 4.12). В появившемся окне 
New Symbol Properties (рис. 4.18) введем имя 
нашего символа (My Title) и выберем его тип 
(Title Block). После нажатия кнопки ОК перейдем 
в окно редактирования символа, аналогичное 
окну редактирования элемента (см. рис. 4.15). 

С помощью инструментов редактора 
символов (рис. 4.19, пояснения приведены в табл. 
2.2) нарисуем требуемую основную надпись, при 
этом все подписи выполним с помощью 
инструмента «Текст». 
 Получившаяся основная надпись приведена 
на рис. 4.20. 
 Наша основная надпись пока не содержит 

сведений, относящихся к разработчикам, т.е. не заполнены поля «Разраб.», «Пров.» и 

Рис. 4.18. Окно New Symbol Properties 
 

Рис. 4.19. Инструменты редактора 
символов 
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т.д. Заполнение этих полей с помощью инструмента «Текст» приведет к созданию 
символа с ограниченными возможностями использования, что противоречит 
концепции создания библиотечных элементов. 

В то же время Orcad обладает возможностями автоматического заполнения полей 
основной надписи при создании нового проекта, при этом автозаполнение 
производится в соответствии с установками шаблона Design Template, для изменения 
которого необходимо выполнить пункты меню OptionsDesign Template. 
 
 
 
 
 
 
 
  
 

Рис. 4.20. Основная надпись 

 Отложим на некоторое время процесс создания основной надписи и рассмотрим 
возможности автозаполнения. Выполним пункты меню OptionsDesign Template, 

после чего перейдем на вкладку Title Block. 
Появится окно, приведенное на рис. 4.21. Девять 
полей, объединенных в группу Text, доступны для 
ввода данных, используемых при автозаполнении. 
Для реализации данной возможности необходимо 
вставить в основную надпись ссылки на эти поля.  

Закроем окно рис. 4.21 и вернемся к 
редактированию символа. 
 Щелкнем два раза левой кнопкой мыши в 
окне редактора символом (либо выполним пункты 
меню OptionsPart Properties), в результате чего 
перейдем в окно редактирования свойств символа 

(рис. 4.22). Создадим новый параметр, для чего нажмем кнопку New. В появившемся 
окне (рис. 4.23) в графе Name введем название параметра в соответствии с табл. 4.1, 
графу Value оставим пустой. 
 
 
 
 
 
 
 
 
 
 
 

Рис. 4.21. Окно Design Template 

Рис. 4.22. Окно редактирования 
свойств символа 

Рис. 4.23. Окно создания нового 
параметра 

Би
бл
ио
те
ка

 БГ
УИ
Р



 

Таблица 4.1 
Ссылки на поля шаблона Design Template 

Название поля в шаблоне 
Design Template  Название параметра 

Title Title 
Organization Name OrgName 

Organization Address 1 OrgAddr1 
Organization Address 2 OrgAddr2 
Organization Address 3 OrgAddr3 
Organization Address 4 OrgAddr4 

Document Number Doc 
Revision RevCode 

Cage Code Cage Code 
 

Закроем окно создания нового параметра, в окне редактирования свойств символа 
нажмем кнопку Display, затем установим видимость Value Only. Для того чтобы 
надпись можно было заполнить на русском языке, в разделе Font нажмем кнопку 
Change, затем в поле Набор символов выберем пункт Кириллица. Аналогично 
создадим другие параметры. Для того чтобы вставить дату, необходимо в качестве 
названия параметра выбрать Design Create Date. 

Часть основной надписи с созданными автозаполняемыми полями приведена на 
рис. 4.24, при этом для ввода фамилий 
разработчика, контролера и проверяющего 
использованы поля Organization Address (адрес 
организации), т.к. адрес организации согласно 
ГОСТу в основную надпись не входит.  
 Сохраним созданную библиотеку, выполнив 
пункты меню FileSave As (при этом для того, 
чтобы сохранилась  
именно библиотека с расширением файла *.olb, 
необходимо, чтобы в окне менеджера проекта было 
выделено название библиотеки (см. рис. 4.12)).  
 Проверим функционирование нашего 

элемента. Для этого произведем редактирование шаблона Design Template, заполнив 
необходимые поля в группе Text в соответствии с выбранными связями с полями 
основной надписи. Также необходимо заполнить поля в группе Symbol, указав в графе 
Library Name название созданной библиотеки с полным путем к ней (например 
C:\Program Files\OrcadLite\Capture\Library\MyLib.olb), а в графе Title Block Name – 
название созданной основной надписи (в нашем случае My Title). 

Создав новый проект, убедимся, что место основной надписи заняла созданная 
нами надпись, при этом поля с автозаполнением имеют правильные значения. 

Рис. 4.24. Часть основной надписи 
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5. ОПТИМИЗАЦИЯ РАБОТЫ ЭЛЕКТРОННЫХ СХЕМ 

5.1. Основные понятия 
В процессе анализа электронной схемы, созданной разработчиком, может 

оказаться, что ее функционирование не вполне отвечает требованиям технического 
задания. Такое расхождение чаще всего обусловлено тем, что современные 
электронные схемы содержат большое число нелинейных элементов, в силу чего для 
расчета схемы используются приближенные методы, основанные на различных 
вариантах линеаризации.  
 Для достижения требуемых технических характеристик необходимо произвести 
коррекцию первоначальных значений параметров элементов схемы. Для этого 
существуют два пути: 

1. Многократное моделирование схемы при ручном изменении параметров 
элементов с целью определения влияния каждого из них на значения требуемых 
выходных  характеристик с последующими подбором и фиксацией требуемых 
значений. 

2. Автоматизированный подбор параметров с помощью программы PSpice 
Optimizer. 

Второй путь позволяет значительно сократить затраты машинного времени и 
усилия разработчика. 

Перед использованием программы PSpice Optimizer дадим определения основным 
понятиям: 

Оптимизация (Optimization) – процесс точной настройки работы схемы путем 
вариации ее параметров до достижения заданного (или наиболее близкого к 
заданному) значения глобальной целевой функции. 

PSpice Optimizer позволяет производить следующие виды оптимизации: 
Оптимизация без ограничений (Unconstrained optimization). При этом вычисляется 

экстремум одной целевой функции.  
Оптимизация при ограничениях (Constrained optimization). Вычисляется 

экстремум одной целевой функции при выполнении одного или нескольких 
неравенств. 

Минимизация по методу наименьших квадратов без ограничений (Unconstrained 
least squares). Минимизирует сумму квадратов ошибок (разниц между заданными и 
текущими значениями) для набора целевых функций. 

Минимизация по методу наименьших квадратов при ограничениях (Constrained 
least squares). Минимизирует сумму квадратов ошибок  для набора целевых функций 
при выполнении заданных неравенств. 
 Параметр (Parameter) – свойство схемы, для которого PSpice Optimizer 
пытается определить лучшее значение в заданных пользователем пределах. В 
качестве параметра может использоваться: 
 номинал элемента (например емкость конденсатора); 
 другое свойство элемента (например положение движка потенциометра); 
 член выражения, определяющий свойство элемента (например коэффициент в 
записи передаточной функции). 

PSpice Optimizer может оптимизировать схему, содержащую до восьми 
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варьируемых параметров. 
 Спецификация (Specification) – описание глобальной целевой функции с 
помощью локальных целевых функций и ограничений. В PSpice Optimizer 
существуют два типа спецификаций: 
 Внутренняя (internal specification), состоящая из целевых функций (заданных 
своими значениями) и неравенств (заданных в виде допустимых пределов), которые 
введены в PSpice Optimizer с помощью диалоговых окон. 
 Внешняя (external specification), состоящая из результатов измерений, заданных 
в виде внешнего файла. 
 При задании спецификации необходимо указать: 
 название (Name); 
 значение глобальной целевой функции (Target) и ее допустимое отклонение 
(Range); 
 вид анализа схемы (Analysis); 
 название профиля моделирования либо файла-описания схемы (Simulation 
Profile or Circuit File); 
 выражение для описания глобальной целевой функции (в графе Evaluate). 
 Спецификация также может включать: 
 название probe-файла, содержащего описание целевых функций (Probe file 
containing Goal Functions); 
 имя файла, содержащего результаты измерений и опорные данные (при 
использовании внешней спецификации). 
 Глобальная целевая функция (Evaluation) – функция, значение которой 
является мерой соответствия реального режима в схеме желаемому. 
 В качестве глобальной целевой функции могут выступать: 
 1. Одноточечная trace-функция программы PSpice. 
 2. Локальная целевая функция (Goal Function) программы PSpice. 
 3. Выражение программы PSpice Optimizer. 
 Trace-функция определяет требуемый выходной параметр схемы при 
проведении одноточечного анализа (например DC sweep при фиксированном входном 
напряжении в 12 В).  

Примеры: V(out) для измерения выходного напряжения; I(d1) – для измерения 
тока через диод. 
 Локальная целевая функция (Goal Function) определяет требуемый выходной 
параметр при проведении всех остальных видов анализа, кроме одноточечного 
(например AC, Tran).  

Локальная целевая функция вычисляется по результатам моделирования схемы 
при фиксированных значениях параметров.  

Встроенные локальные целевые функции программы PSpice приведены       в табл. 
5.1. 
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Таблица 5.1 
Локальные целевые функции программы PSpice 

Функция Назначение Пример 
Bandwidth(выражение,  

уровень в дБ), 
 

BPBW(выражение, уровень 
в дБ) 

Ширина полосы пропускания 
полосового фильтра, определяемая 

по заданному уровню  

Bandwidth(V(out),3) 
 

BPBW(V(out),3) 
 

CenterFreq(выражение, 
уровень в дБ) 

Центральная частота полосы 
пропускания CenterFreq (V(5),3) 

Falltime(выражение) Длительность заднего фронта Falltime(I(R)) 

GainMargin(выр.1, выр.2) 

Определяет (в дБ) значение 
амплитуды для выражения 2, при 
котором набег фазы выражения 1 

достигает 180О  

GainMargin(P(V(out)), 
V(out)) 

GenFall(выражение) Длительность заднего фронта 
огибающей сигнала GenFall(V(out)) 

GenRise(выражение) Длительность переднего фронта 
огибающей сигнала GenRise(V(out)) 

HPBW(выражение, уровень в 
дБ) 

Ширина полосы пропускания 
фильтра верхних частот, 

определяемая по заданному 
уровню 

HPBW(V(out),3) 
 

LPBW(выражение, уровень в 
дБ) 

Ширина полосы пропускания 
фильтра нижних частот  

HPBW(V(out),3) 
 

MAX(выражение) Глобальный максимум Max(I(R)) 

MAXr(выр., t1, t2) Локальный максимум выражения 
на интервале времени от t1 до t2 Maxr(V(3), 0, 2s) 

MIN(выражение) Глобальный минимум Min(I(R)) 

MINr(выр., t1, t2) Локальный минимум выражения 
на интервале времени от t1 до t2 Minr(V(3), 0, 2s) 

Overshoot(выражение)   
Определяет разницу между 
максимальным и конечным 

значением выражения 
Overshoot(V(out))   

Peak(выражение, n) Значение выражение в n-м пике Peak(V(out), 2) 

Period(выражение) Период сигнала. Определяется от 
первого до второго импульса Period(V(out)) 

PhaseMargin(выр.1, выр.2) 

Определяет значение фазы 
выражения 2, при котором 

амплитуда выражения 1 достигает 
значения ноль дБ 

PhaseMargin(V(out), 
P(V(out))) 

Pulsewidth(выражение) 

Длительность импульса   
(определяется как интервал 

времени от середины 
положительного до середины 

отрицательного фронта) 

Pulsewidth(V(out)) 

Risetime(выражение) Длительность переднего фронта Risetime(V(out)) 

SWINGr(выр.,нач._x,кон_x) 
Разница между максимальным и 

минимальным значением 
выражения в указанном интервале 

SWINGr(V(out),0,8ms) 

Окончание табл. 5.1 
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Функция Назначение Пример 

TPmW2(выр., период) 

Вычисляет функцию 
 (y1-y2)*1000/(x1-x2) 

 от выражения на указанном 
периоде.  

Может использоваться для 
расчета общей рассеиваемой 

мощности (в мВт) на указанном 
периоде, если 

выр.=интеграл(V(out)*I(out)) 

TPmW2(s(V(out)* 
I(out)), 5) 

XatNthY(выр.,зн_Y,n) 

Находит значение Х для 
выражения, соответствующее n-

му повторению заданного 
значения Y 

XatNthY(V(out),10,1) 

XatNthYn(выр.,зн_Y,n) 

Находит значение Х для 
выражения, соответствующее n-

му отрицательному фронту, 
пересекающего заданное  

значение Y 

XatNthYn(V(out),10,1) 

XatNthYp(выр.,зн_Y,n) 

Находит значение Х для 
выражения, соответствующее n-

му положительному фронту, 
пересекающего заданное  

значение Y 

XatNthYp(V(out),10,1) 

XatNthYpct(выр.,Y_в_проц.,n) 

Находит значение Х для 
выражения, соответствующее n-

му пересечению значения Y, 
заданного в процентах от 
максимальной амплитуды 

XatNthYpct(V(out), 
50,1) 

YatX(выр., зн_X) Находит значение выражения 
при заданном значении Х YatX(V(3),20) 

YatXpct(выр.,X_в_проц.) 
Находит значение выражения 
при заданном в процентах от 

полного диапазона значении Х 
YatXpct(V(3),75) 

Выражение PSpice Optimizer содержит переменные, константы, функции и 
операторы программы PSpice Optimizer. Например, для вычисления общего 
сопротивления двух резисторов с параметризованными значениями сопротивлений 
R1val и R2val можно использовать выражение R1val «operator» R2val, где вместо 
«operator» необходимо использовать «+», «–», «*», « / », «**» (возведение в степень). 
Допустимо использовать также функции sin, cos, tan, atan, exp, log, log10. 
 Схемы, не подлежащие оптимизации: 
 1. Неработающие схемы. PSpice Optimizer не сможет «оживить» схему, 
содержащую ошибки, не позволяющие провести ее моделирование. 
 2. Схемы, содержащие элементы с несколькими состояниями (например 
триггеры), если при незначительном изменении параметра изменяется состояние 
схемы. 
 
 

Би
бл
ио
те
ка

 БГ
УИ
Р



 

5.2. Оптимизация схемы с помощью программы PSpice Optimizer 
 Алгоритм оптимизации схемы с помощью программы PSpice Optimizer 
рассмотрим на конкретном примере. 
 Пример: подбором номинала R5 добиться того, чтобы в схеме рис. 5.1 ток через 
нелинейный элемент (диод) составил 1мА с точностью 1%.  

 
1. Промоделируем данную схему на 

постоянном токе с помощью программы 
Capture. Для этого соберем схему, проведем 
расчет переходного процесса (Time Domain), 
затем выведем результаты расчета по 
постоянному току, для чего из меню PSpice 
выберем пункты Bias Points → Enable, затем 
на панели инструментов нажмем кнопку «I». 
Результаты моделирования приведены на 
рис. 5.2. (На этом рисунке значения всех 

токов, кроме интересующего, убраны). Видим, что при данных параметрах ток через 
диод составляет 1,828 мА. 

2. Параметризируем значение 
сопротивления R5, для чего заменим 
значение 1К для R5 записью с именем 
параметра в фигурных скобках, например 
{R5val}. 

3. В программе Capture из меню PSpice 
выберем пункт Place  

 
Optimizer Parameters и поместим 

появившуюся рамку на удобном месте. 
4. Дважды щелкнув левой кнопкой мыши 

на рамке, перейдем в окно ввода параметра, 
приведенное на рис. 5.3. 

Поля этого окна имеют следующие 
назначения: 
    Name – название параметра; 

    Initial Value – значение, с которого 
начинается процесс оптимизации; 

    Current Value – текущее значение 
параметра; 
       Tolerance – допуск на параметр. Задается 
для последующего выбора значения из 
стандартного ряда; 
 
 

Lower Limit – нижний допустимый предел изменения параметра; 
 Upper Limit – верхний допустимый предел изменения параметра. 

U=10В 

R1 

1K 

R2 

R3 

8K 

R4 

2K 

R5 

1K VD 

Рис. 5.1. Схема примера 

Рис. 5.2. Результат расчета  
исходной схемы 

Рис. 5.3. Окно ввода параметра  
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 Переключатель Simulation With позволяет проводить моделирование из 
программы Capture либо с начальным значением параметра (Initial Value), либо с 
текущим (Current Value).  

Заполним верхние поля так, как показано на рисунке, затем нажмем кнопки Add и 
ОК.  

5. Запустим программу PSpice Optimizer, выбрав в программе Capture пункты 
меню PSpice → Run Optimizer. В результате получим окно программы PSpice 
Optimizer, приведенное на рис. 5.4. 

 Окно состоит из трех основных 
частей: области спецификаций 
(Specifications), области параметров  
 

 
 
 
 
 
 
(Parameters), области индикатора процесса оптимизации. Видим, что пока область 
спецификаций пуста.  
 6. Добавим глобальную целевую функцию, для чего в меню Edit данной 
программы выберем пункт Specifications. В появившемся окне нажмем кнопку Add, в 
результате чего появится окно Edit Specification, приведенное на рис. 5.5. Поля этого 
окна имеют следующие назначения: 

Name – название глобальной целевой функции; 
Reference – источник ее описания: 

    Internal – поле Evaluate; 
    External – внешний файл; 

Target – желаемое значение глобальной целевой функции; 
Range – ее допустимое отклонение; 
Constraint – наличие ограничений-неравенств, вид которых выбирается из поля 

Type; 
Analysis – вид анализа схемы (AC, DC либо Tran); 
Simulation Profile or Circuit File – название профиля моделирования либо файла-

описания схемы; 
 Probe File Containing Goal Functions – имя файла с расширением .prb, 

Рис. 5.5. Окно Edit Specification 

Рис. 5.4. Окно программы 
 PSpice Optimizer 
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содержащего описание локальных целевых функций (например C:\Program 
Files\OrcadLite\PSpice\Common\pspice.prb); 
 Evaluate – описание глобальной целевой функции. 

При использовании нескольких целевых функций можно задать удельный вес 
каждой из них в графе Weigth. 
 При использовании внешнего описания целевой функции необходимо 

заполнить поля: 
 File – имя файла с данными; 
 X Column Name – заголовок столбца в файле, 
содержащего независимые (Х) значения (например Vbe на 
рис. 5.6.); 
 Y Column Name – заголовок столбца в файле, 
содержащего зависимые (Y) значения (например Ic на рис. 
5.6.); 
 Tolerance – допуск в процентах, задаваемый для 
последующего выбора значения параметра из стандартного 
ряда (например 10%). 

Заполним поля окна Edit Specifications так, как показано на рис. 5.5; закроем это 
окно, нажав ОК. После этого закроем окно Specifications с помощью кнопки Close. 

Видим, что в поле Specifications появилось окно, показанное 
на рис. 5.7. В верхней части окна находится переключатель, 
включающий/исключающий целевую функцию из процесса 
вычислений. Белое поле в середине окна содержит текущее 
значение функции, нижнее поле – начальное значение. В 
правой части окна находится индикатор, показывающий  

 соответствие значения целевой функции заданному. Если 
индикатор имеет красный цвет, то функция не достигла 
заданного значения, при этом по меткам в правой части 
шкалы можно видеть, больше или меньше заданного текущее 

значение глобальной целевой функции. При достижении заданного значения 
индикатор меняет цвет на зеленый. 

7. Для того чтобы можно было запустить процесс оптимизации, необходимо 
соответствие между видом анализа, указанного в окне Edit Specification (см. рис. 5.5), 
и профилем моделирования в программе Capture. Для расчета схемы по постоянному 
току мы использовали режим Tran, поэтому необходимо: 

I вариант. Снова открыть окно Edit Specification, для чего либо дважды щелкнуть 
левой кнопкой мыши на правой части окна рис. 5.7, либо выполнить пункты меню 
EditSpecifications; после чего выбрать вид анализа Tran. Так как Tran является 
многоточечным видом анализа, то в качестве глобальной целевой функции в графе 
Evaluate необходимо задать выражение, содержащее локальные целевые функции, 
например MAX(I(D1)). После выхода из окон Edit Specification и Specifications можно 
запускать процесс оптимизации. 

II вариант. Для сокращения времени моделирования задать одноточечный вид 
анализа, для чего вернуться в программу Capture и отредактировать профиль 
моделирования, например так, как показано на рис. 5.8.  

Рис. 5.6. Структура 
 файла-описания целевой 

функции 

Рис. 5.7. Окно 
глобальной целевой 

функции 
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Запустим процесс оптимизации, для чего в 
меню Tune программы PSpice Optimizer (см. 
рис. 5.4) выберем пункты Auto → Start. Ход 
процесса отображается в левой части окна 
PSpice Optimizer, в которой находится 
индикатор, показывающий, насколько далеки 
значения глобальных целевых функций от 
желаемых значений (первоначально индикатор 
показывает 100 %). Под индикатором находятся 
поля со значениями среднеквадратической 
ошибки (RMS Error), номера текущей итерации, 
используемой для подбора параметров 
(Iteration), числа запусков процесса 

моделирования с помощью программы PSpice (Simulations). 
После окончания оптимизации схемы получим значение тока 1,00023 мА при 

значении сопротивления R5, равном 3,89443К.  
8. Округлим полученное значение сопротивления до ближайшего стандартного, 

взятого из ряда Е12 (что соответствует указанному допуску 10 %), для чего выполним 
пункты меню EditRound Nearest. В результате получим значение R5, равное 3,9К; 
при этом ток через диод будет равен 0,99937 мА. 

При наличии у разработчика достаточных оснований можно создать новое 
стандартное значение, для чего выполнить пункты меню EditRound Calculated. 
 9. Внесем полученное значение в схему в программе Capture, для чего 
выполним пункты меню EditUpdate Schematic. В результате рамка Optimizer 
Parameter примет вид, показанный на рис. 5.9, а. 
 10. Промоделируем схему с новым значением параметра так же, как в первом 
пункте. Убедимся, что функционирование схемы соответствует ожидаемому (рис. 5.9, 
б). 
 
 
 
 
 
 
 
 
 
 
 
 

 
Рис. 5.9. Результаты оптимизации схемы 

 
 
 
 

Рис. 5.8. Профиль моделирования 

а 
б 
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